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1   Introduction 

The 3-D Map Data Tour file format is used to display an interactive 3-D visualization of data over a 
map. The visualization can contain multiple parts which focus on one or multiple places on the map 
and depict different time scales and the events associated with the data.  

Sections 1.7 and 2 of this specification are normative and can contain the terms MAY, SHOULD, 
MUST, MUST NOT, and SHOULD NOT as defined in RFC 2119. All other sections and examples in this 
specification are informative. 

1.1   Glossary 

The following terms are defined in [MS-GLOS]: 

XML 

The following terms are defined in [MS-OFCGLOS]: 

animation 
data point 
theme 

ToolTip 
workbook 

The following terms are specific to this document: 

camera: A virtual representation of a camera that controls the position of the viewer window 
inside the 3-D environment. 

effect: A user-specified camera motion that occurs for the duration of a scene. 

scene: An independent part of a tour that has a beginning and end, and a specific time duration 
in which a particular data visualization on the map occurs.  

tour: A scene or sequence of scenes that describe a story about geographical locations, time 
periods, and data visualization. 

transition: The camera path and time period that connects one scene to another. 

MAY, SHOULD, MUST, SHOULD NOT, MUST NOT: These terms (in all caps) are used as 
described in [RFC2119]. All statements of optional behavior use either MAY, SHOULD, or 

SHOULD NOT. 

1.2   References 

References to Microsoft Open Specifications documentation do not include a publishing year because 
links are to the latest version of the documents, which are updated frequently. References to other 
documents include a publishing year when one is available. 

1.2.1   Normative References 

We conduct frequent surveys of the normative references to assure their continued availability. If 
you have any issue with finding a normative reference, please contact dochelp@microsoft.com. We 
will assist you in finding the relevant information. 

%5bMS-GLOS%5d.pdf
%5bMS-OFCGLOS%5d.pdf
http://go.microsoft.com/fwlink/?LinkId=90317
mailto:dochelp@microsoft.com
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[RFC2119] Bradner, S., "Key words for use in RFCs to Indicate Requirement Levels", BCP 14, RFC 
2119, March 1997, http://www.rfc-editor.org/rfc/rfc2119.txt 

[XMLSCHEMA1] Thompson, H.S., Beech, D., Maloney, M., and Mendelsohn, N., Eds., "XML Schema 
Part 1: Structures", W3C Recommendation, May 2001, http://www.w3.org/TR/2001/REC-

xmlschema-1-20010502/ 

[XMLSCHEMA2] Biron, P.V., and Malhotra, A., Eds., "XML Schema Part 2: Datatypes", W3C 
Recommendation, May 2001, http://www.w3.org/TR/2001/REC-xmlschema-2-20010502/ 

1.2.2   Informative References 

[MS-GLOS] Microsoft Corporation, "Windows Protocols Master Glossary". 

[MS-OFCGLOS] Microsoft Corporation, "Microsoft Office Master Glossary". 

1.3   Overview 

This structure allows the exploration and visualization of data on a map, which can be a flat 3-D 
surface or a 3-D globe. This structure allows for animating over time and visualization of historical 
trends of the data over time. This structure also allows for various levels of visualization using 2-D 
visuals which can be anchored to the top level of the 3D environment. These 2-D visuals can be text 

boxes or flat 2-D charts that provide more insights into the data. This structure is capable of 
displaying multiple layers of data and users can change specific visual properties of the extrusions 
representing the accumulated data on the globe. It is also possible to animate the data using 
different aggregation options over time, or partition the animation over common units of time – 
such as days, weeks, or months. This structure supports annotations that are anchored to data 
extrusions, and the annotations can contain custom text and/or generic ToolTips which are derived 
from the data. This structure can support different styles of data shapes and visual map themes, 

and different chart types, such as heat maps or pie charts which appear as data extrusions in the 
data. The structure supports sequencing of different parts which are called scenes; a specific 
sequence of these scenes is called a tour. Each scene has a specific motion to it, called a 
transition, as well as motion which is an option for the duration of the scene, called an effect. 

1.4   Relationship to Protocols and Other Structures 

This structure depends on geocoding and mapping services. These are public and can be provided 

from a variety of vendors. This structure also depends on data query APIs for data rendering in the 
3-D environment.    

1.5   Applicability Statement 

This structure should be used when an application renders a 3-D geospatial data collection of scenes 
which collectively describe a story about data on a map inside a 3-D mapped environment.  

1.6   Versioning and Localization 

Structure Versions: This structure specifies the only version of the 3-D Map Data Tour file format. 

Localization: The file format allows one or more of the following elements to be stored in their 

localized form. 

Workbook column names 

Tour name 

http://go.microsoft.com/fwlink/?LinkId=90317
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90610
%5bMS-GLOS%5d.pdf
%5bMS-OFCGLOS%5d.pdf
%5bMS-OFCGLOS%5d.pdf
%5bMS-OFCGLOS%5d.pdf
%5bMS-OFCGLOS%5d.pdf
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Scene name 

Layer name 

Text box content 

Annotation content 

Date and time format 

1.7   Vendor-Extensible Fields 

None. 
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2   Structures 

2.1   Complex Types 

2.1.1   CT_Camera 

Target namespace: http://microsoft.data.visualization.engine.tours/1.0 

Referenced by: CT_Frame 

Specifies the position of the camera in the initial frame of a scene. 

Child Elements: 

Latitude: An xs:decimal ([XMLSCHEMA2] section 3.2.3) element that specifies the latitude of the 
camera target in degrees. 

Longitude: An xs:decimal ([XMLSCHEMA2] section 3.2.3) element that specifies the longitude of 
the camera target in degrees. 

Rotation: An xs:decimal ([XMLSCHEMA2] section 3.2.3) element that specifies the rotation angle 
of the camera in radians. This value is zero when the camera is pointing north. 

PivotAngle: An xs:decimal ([XMLSCHEMA2] section 3.2.3) element that specifies the vertical 
angle between a tangential plane at the target point and the line drawn from the target to the 
camera. 

Distance: An xs:decimal ([XMLSCHEMA2] section 3.2.3) element that specifies the normalized 
camera distance to the target position. A distance of 1.0 equals the radius of the earth. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

<xsd:complexType name="CT_Camera"> 

  <xsd:sequence> 

    <xsd:element name="Latitude" type="xsd:decimal"/> 

    <xsd:element name="Longitude" type="xsd:decimal"/> 

    <xsd:element name="Rotation" type="xsd:decimal"/> 

    <xsd:element name="PivotAngle" type="xsd:decimal"/> 

    <xsd:element name="Distance" type="xsd:decimal"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.2   CT_Frame 

Target namespace: http://microsoft.data.visualization.engine.tours/1.0 

Referenced by: CT_Scene 

Specifies the initial frame of a scene. 

Child Elements: 

http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
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Camera: A CT_Camera (section 2.1.1) element that specifies the parameters of the camera in its 
initial position in the frame. 

Image: A xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the image for the frame. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 

complex type. 

<xsd:complexType name="CT_Frame"> 

  <xsd:sequence> 

    <xsd:element name="Camera" type="tns:CT_Camera"/> 

    <xsd:element name="Image" type="xsd:string"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.3   CT_Scene 

Target namespace: http://microsoft.data.visualization.engine.tours/1.0 

Referenced by: CT_Scenes 

Specifies a scene in the tour. 

Child Elements: 

Transition: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the type of camera 
transition for this scene. Can only be set to "MoveTo". 

Effect: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the camera motion 
effect. Possible values are "Station", "Circle", "Dolly", "FlyOver", "PushIn", "Figure8" and 
"RotateGlobe". 

Theme: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the type of theme 
applied to this scene. Possible values are "BingRoad", "BingRoadHighContrast", "Aerial", "Grey", 

"Dark", "Light", "Mono", "White", "Earthy", "Modern", "Organic", and "Radiate". 

ThemeWithLabel: An xs:boolean ([XMLSCHEMA2] section 3.2.2) element that specifies whether a 
theme with labels enabled has been applied to this scene. 

FlatModeEnabled: An xs:boolean ([XMLSCHEMA2] section 3.2.2) element that specifies whether 
the scene has a 3-D map represented as a globe. A value of 1 indicates that the map is represented 
in as a globe; a value of 0 indicates that the map is represented as a flat surface.  

Duration: An xs:unsignedInt ([XMLSCHEMA2] section 3.3.22) element that specifies the scene 
duration in 100-nanosecond units. 

TransitionDuration: An xs:unsignedInt ([XMLSCHEMA2] section 3.3.22) element that specifies 

the duration of the scene transition in 100-nanosecond units. 

Speed: An xs:decimal ([XMLSCHEMA2] section 3.2.3) element that specifies the relative speed of 
the scene effect. Possible values lie between 0 and 1. 

Frame: A CT_Frame (section 2.1.2) element that specifies the first frame of this scene in the 

Power Map tour. 

http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
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LayersContent: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the contents of 
a scene in the tour. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

<xsd:complexType name="CT_Scene"> 

  <xsd:sequence> 

    <xsd:element name="Transition" type="xsd:string"/> 

    <xsd:element name="Effect" type="xsd:string"/> 

    <xsd:element name="Theme" type="xsd:string"/> 

    <xsd:element name="ThemeWithLabel" type="xsd:boolean"/> 

    <xsd:element name="FlatModeEnabled" type="xsd:boolean"/> 

    <xsd:element name="Duration" type="xsd:unsignedInt"/> 

    <xsd:element name="TransitionDuration" type="xsd:unsignedInt"/> 

    <xsd:element name="Speed" type="xsd:decimal"/> 

    <xsd:element name="Frame" type="tns:CT_Frame"/> 

    <xsd:element name="LayersContent" type="xsd:string"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.4   CT_Scenes 

Target namespace: http://microsoft.data.visualization.engine.tours/1.0 

Referenced by: CT_Tour 

Specifies the collection of scenes in the Power Map tour. There is always at least one scene per tour. 

Child Elements: 

Scene: A CT_Scene (section 2.1.3) element that specifies a scene in a Power Map tour. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 

complex type. 

<xsd:complexType name="CT_Scenes"> 

  <xsd:sequence> 

    <xsd:element maxOccurs="unbounded" name="Scene" type="tns:CT_Scene"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.5   CT_Tour 

Target namespace: http://microsoft.data.visualization.engine.tours/1.0 

Referenced by: Tour 

Specifies a Power Map tour. 

Child Elements: 

http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
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Scenes: A CT_Scenes (section 2.1.4) element that specifies a collection of scenes within the tour. 

Attributes: 

Name: An xs:string ([XMLSCHEMA2] section 3.2.1) attribute that specifies the name of the tour. 

Description: An xs:string ([XMLSCHEMA2] section 3.2.1) attribute that specifies the description of 

the tour. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

<xsd:complexType name="CT_Tour"> 

  <xsd:sequence> 

    <xsd:element name="Scenes" type="tns:CT_Scenes"/> 

  </xsd:sequence> 

  <xsd:attribute name="Name" type="xsd:string" use="required"/> 

  <xsd:attribute name="Description" type="xsd:string" use="required"/> 

</xsd:complexType> 

See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.6   CT_Tour 

Target namespace: http://microsoft.data.visualization.Client.Excel/1.0 

Referenced by: CT_Tours 

Specifies a tour comprised of one or more scenes in Power Map. 

Child Elements: 

Description: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the description of 
the tour. 

Image: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the image that 
represents the tour. 

Attributes: 

Name: An xs:string ([XMLSCHEMA2] section 3.2.1) attribute that specifies the name of the tour. 

Id: An xs:string ([XMLSCHEMA2] section 3.2.1) attribute that specifies a unique identifier for the 
version of the tour. 

TourId: An xs:string ([XMLSCHEMA2] section 3.2.1) attribute that specifies a unique identifier for 
the tour. 

XmlVer: An xs:unsignedByte ([XMLSCHEMA2] section 3.3.24) attribute that specifies the current 
version of the XML representation of the tour. 

MinXmlVer: An xs:unsignedByte ([XMLSCHEMA2] section 3.3.24) attribute that specifies the 
minimum compatible XML version of the tour. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90610
%5bMS-GLOS%5d.pdf
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90608
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<xsd:complexType name="CT_Tour"> 

  <xsd:sequence> 

    <xsd:element name="Description" type="xsd:string"/> 

    <xsd:element name="Image" type="xsd:string"/> 

  </xsd:sequence> 

  <xsd:attribute name="Name" type="xsd:string" use="required"/> 

  <xsd:attribute name="Id" type="xsd:string" use="required"/> 

  <xsd:attribute name="TourId" type="xsd:string" use="required"/> 

  <xsd:attribute name="XmlVer" type="xsd:unsignedByte" use="required"/> 

  <xsd:attribute name="MinXmlVer" type="xsd:unsignedByte" use="required"/> 

</xsd:complexType> 

See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.7   CT_Tours 

Target namespace: http://microsoft.data.visualization.Client.Excel/1.0 

Referenced by: CT_Visualization 

Specifies the collection of tours contained within a workbook. 

Child Elements: 

Tour: A CT_Tour (section 2.1.6) element that specifies a tour. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

<xsd:complexType name="CT_Tours"> 

  <xsd:sequence> 

    <xsd:element maxOccurs="unbounded" name="Tour" type="tns:CT_Tour"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.8   CT_Visualization 

Target namespace: http://microsoft.data.visualization.Client.Excel/1.0 

Referenced by: Visualization 

Specifies the 3-D visualizations stored in a workbook. 

Child Elements: 

Tours: A CT_Tours (section 2.1.7) element that specifies the collection of tours stored in the 
workbook. 

Colors: An xs:anyType ([XMLSCHEMA1] section 3.4.7) element that specifies the custom color 
palette selected by the user for the visualizations. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

http://go.microsoft.com/fwlink/?LinkId=90608
%5bMS-OFCGLOS%5d.pdf
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
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<xsd:complexType name="CT_Visualization"> 

  <xsd:sequence> 

    <xsd:element name="Tours" type="tns:CT_Tours"/> 

    <xsd:element name="Colors"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.9   CT_VisualizationLState 

Target namespace: http://microsoft.data.visualization.Client.Excel.LState/1.0 

Referenced by: VisualizationLState 

Specifies a container for geocoded data points (1) within Power Map. 

Child Elements: 

cg: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the geocoded data points 
(1). 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

<xsd:complexType name="CT_VisualizationLState"> 

  <xsd:sequence> 

    <xsd:element name="cg" type="xsd:string"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.2 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.1.10   CT_VisualizationPState 

Target namespace: http://microsoft.data.visualization.Client.Excel.PState/1.0 

Referenced by: VisualizationPState 

Specifies the container for data used for mapping regions. 

Child Elements: 

rp: An xs:string ([XMLSCHEMA2] section 3.2.1) element that specifies the region polygons. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
complex type. 

<xsd:complexType name="CT_VisualizationPState"> 

  <xsd:sequence> 

    <xsd:element name="rp" type="xsd:string"/> 

  </xsd:sequence> 

</xsd:complexType> 

See section 5.3 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

http://go.microsoft.com/fwlink/?LinkId=90608
%5bMS-OFCGLOS%5d.pdf
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90610
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
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2.2   Elements 

2.2.1   Tour 

Target namespace: http://microsoft.data.visualization.engine.tours/1.0 

A CT_Tour (section 2.1.5) element that specifies a tour in Power Map. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
element. 

<xsd:element name="Tour" type="tns:CT_Tour"/> 

See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.2.2   Visualization 

Target namespace: http://microsoft.data.visualization.Client.Excel/1.0 

A CT_Visualization (section 2.1.8) element that specifies the 3-D visualizations stored in the 
workbook. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
element. 

<xsd:element name="Visualization" type="tns:CT_Visualization"/> 

See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.2.3   VisualizationLState 

Target namespace: http://microsoft.data.visualization.Client.Excel.LState/1.0 

A CT_VisualizationLState (section 2.1.9) element that specifies a container for geocoded data 
points (1). 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
element. 

<xsd:element name="VisualizationLState" type="tns:CT_VisualizationLState"/> 

See section 5.2 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

2.2.4   VisualizationPState 

Target namespace: http://microsoft.data.visualization.Client.Excel.PState/1.0 

A CT_VisualizationPState (section 2.1.10) element that specifies a container for data used for 
region mappings. 

The following W3C XML Schema ([XMLSCHEMA1] section 2.1) fragment specifies the contents of this 
element. 

http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
http://go.microsoft.com/fwlink/?LinkId=90608
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<xsd:element name="VisualizationPState" type="tns:CT_VisualizationPState"/> 

See section 5.3 for the full W3C XML Schema ([XMLSCHEMA1] section 2.1). 

http://go.microsoft.com/fwlink/?LinkId=90608
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3   Structure Examples 

The following is an example of the structure with a tour that has a single scene.  

<?xml version="1.0" encoding="UTF-16"?> 

<Tour xmlns="http://microsoft.data.visualization.engine.tours/1.0" Description="Some description 
for the tour goes here" Name="Tour 1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema"><Scenes><Scene><Transition>MoveTo</Tran
sition><Effect>Station</Effect><Theme>White</Theme><ThemeWithLabel>false</ThemeWithLa
bel><FlatModeEnabled>false</FlatModeEnabled><Duration>60000000</Duration><TransitionDur

ation>30000000</TransitionDuration><Speed>0.5</Speed><Frame><Camera><Latitude>40.96
8825575557013</Latitude><Longitude>-
111.36067867162427</Longitude><Rotation>0</Rotation><PivotAngle>-
0.19670261929383437</PivotAngle><Distance>0.6</Distance></Camera><Image>iVBORw0KGg
oAAAANSUhEUgAAANQAAAB1CAYAAAA2ns9TAAAAAXNSR0IArs4c6QAAAARnQU1BAACxjwv8YQUAAA
AJcEhZcwAAAyQAAAMkAbQeFOYAAC2qSURBVHhe7Z0JkB3Fmec/dUtqSS217vs+ASEhDgmEQQbWCO

xQLDZ4DBh7Gdu7sTHrlTbCE7MzOzETs/asd7wHjvEugwfbM8Y7AgwIkDklhGUd6Ba671tC9y1araNbUrP

1y/f+reyiXr/X770+X/0hlVl5VVXm98/vy6+qX7X5LIC1Ely7ds0qKyuNW2rXrp21bdvWioqK3PHly5etvLzc
Hbdp08bFlAOOFaqrq+3SpUuufYcOHVye6gich0C/5Kufq1evunRxcbE7joKGWzHXkQlUH1y4cME6d+5cK
8+/vlRQfepyjf51btmyxc6cOWNTpkxJ5sRIB2TgypUrbs5rZCkY5Ouz0sJx8eJFq6qqcoTo1q1bDSG46fPnz
zuBBwxESUmJGwQRTOAYUgHyw4Eyhoy+lKYfYgJEFEmoHwZ11I7y8Pl9qE4Y3EuXLl1qzkmdVOcCKlN9
zhkmVIz6A1ljbJGn9u3bu3HNbHlsIZBgl5WV1dIu586dqyEUGkw3T7kvdAoImoTODZJXl1h5aku/BI4J0l4
KEMgnqd83x6kQLlN/gvqK6oM8BaB2fl6M3KC5ZS5ZxEm3KkIhyFp1faFBa5SWljozCdKxskAyCTntAMIJG

CjS5EMUYuqGhbNjx46unvoRsagnQfeDTzxAXqZQGyF8HAbX5Nfxr4P8dO1jpAdjTEDmiNlStCqTDxw5cs
SZQwQfCDLaCbOQASCGZAg+xyIj5NNAUZ98hFDE4Vhp5ase7dUHYGglwBLmfID9IPeHpk3Vp6Y1qpwy
FhX6mLtknV26kqg7uHeZTRw3yqXDoD7ni3EdmnOAfCFTrY5QaB5pIh8IREVFhdtPMRCQiVsnjaAwMBJ6
yEI9yjEfmxu4ZhwI3bt3ryEOqA9hRf4Hpz9re6sHu7xpQ8rt2f/ytL333nvuHAcPHnSmzJgxY9yYfO1rX3P1
YiQAiYBkh4W1VZl8oFOnTrWETEBAuGm0BzGCAmkAwqKYQULrSAuh8Q4fPmyHDh2qyc9HwFPnJiB5DE
FOnz5dqw7n514+/fRTV98vE7gXEYm6CrkAojIOjBnnPXv2rDNvY9QG44McMY+MOY6uVqehuB0EUapYI
F8BwUVbMRA9e/as8fahqSgnLU22detWGzJkiL377rt21113OWcH7SAudTjXjTfeaPv373c2NBoNB0i/fv2c

FmSVp08E8ujRo6588ODBzjzYvXu3M7vuuOMO+/3vf2+jRo1y14WGPXHihBNmrg0yDx8+3F3fhAkTHIF

OnjxpPXr0SN5dApxHEMlSQRpqynd/bAeu9nF5Xx5Rbb/80Z+4dIz0YLxZeBhraalWR6i6gPDreRQDADHQ
WAg7gyEvIWmZfBs3brRx48bZW2+95coR8mHDhrnyzZs32y233OKI9sYbb7i8kSNHOsIi+JDlk08+ccKP
KQqRqDNixAg3EWvXrnXn/+Y3v2l79uyxhQsXunPg8ofI9AXJNmzY4FZCiPbkk0+6a48iFNB0ZkooyCrThf
579erl0jHSA1kCLLJCwRCq6mq1bTv0qe05ctZGdC+yQb07uwHRRhtBVkAYETIIyN6ra9euzvQjH82CCQZ
ZGDq02OjRo92DUQYWEixdutQmTZrk+oUonAeS9O7d23bs2OHIRt+YUvQ5dOhQW7VqlRNoCEc/nA8iI/
AIPmXUv/XWW12bVITKBFw390m/yxfMscsXy11+/yEj7cbxE106RnogG8gJ44i5BwqGUEfOXLS/mLnOl

m47Zjd0qbD/9m/usn49OjtBBZh5CLn2KKRBc3VK5EIotCxaGeLO+5t77J7OO1z+sk5ft6nTf+HSMdJDhA
IQCmIVDKEOnqywH/zyI1u9/aBdLT9h//Yrt9h/fHRysNonVmxIBDDBSGvlQTs1N3Bt7LF880zTWJepxyJB
OXWljaMINX/+fGeqsthwLvaEtB0wYICLMUHRuj/5yU9cu0IFY8PiRIycMJ6tzssXBQSoa8dgAz6mzEquVQT
H1fbq/A22eP1uV86AsOoTR60vCA+rkQ8ESx4eH/ShGPOQfhVr8GmXK8LXCVF8MnF9nNMH5iR5LBh1E
Q/ce++9tnz5cmfKsn9kcVmxYoWtXr3alU+bNs3FhQzGkvlnTpERxrcgNBQ3fL6iwg6d+NT+52+X2sIN+
+3a5Ys2ZnAP+4cffNX6dO/sCIOgoaHYVzE4rDis0qzI7HOOHz/uyvDesWofOHCgZk/D/gYhxkuHV5C69E

E9Avuhffv22d69e+3222937aQV6wvuB49h3759kzkJgokkpJlszEJWTjldILbsfWJCJnsonC8LFiywGTNmJH
NiAC2o0vaMe/EPAyTLWy0QJgSsa2lH69ypg63fddTKLwfCXl7hSDBhZMJtjIBxTH2Elpg8ORZefvll54ygDO
Hs37+/rVu3zgkcXjmZipAQBwRlEIiBZ7+CmcbxoEGDnMcvW0JxjZAUYnONCgITq3Ny/Uy27oXrZtEg7TR
Vu47WtdcA695nkHXr2cc9DgijT58+zpMZozaYawKLLOPpZCYY/FavobhFPHMIYnX1Z/azN1bai/M2WFm7

SrttSGf740fus6H9e7iVm9WcgYGACBfeOYQQgUSLyZvDg1gEE4KRr0HluRN7DepzXvIRboSaevSP5iLOFl
wfXkCedfkQ0egfsuBQ4bw+NN3kc73/YcqPrehgYkEZ8HC1/dUvop9D6flYjOvAKmEeWNh4GM54FoxTAq
BlEIyzFVX2p8+9b2t2HLbu7arsnlFldsfo3jaof183MAg7ZMKLhqZh4CAGQgihIAaDJyJBPkiHeSVNwX6JgW

4IQCje3kBDhuFPp6+1wuD6Cf/5wWet3f7Eq0e9vlJuf/rs0zVOCe6Le0dDLVu2zKZOner6f+CBB+LnVQF4
tsgzR2SFsWZxLQinhAAZuPmyjsU2/dE7rVtpBztzqY0t3nHOPjl9yQ0O+6X169fb9u3b3WoPeIvh448/dhv
yTZs2uQeyixcvdg9iWaEY2CVLlti2bducmcfDYOo0FBDqVOtgKhLVd93kDw3pC0cE2o43NRgTHBVo+xgJ
pwQyxUJKzGJdUBoKsLpDALTVKwu22d+/tsSqr1Ta05PO2Tcfecy27z5t5QGR0DyTJ092rxXxsijDhOnGqo
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6A8bYFJhBvPfDmBIRjgCnTc56HH344edb8ApMODYVpGQbXSYAMmWio5R+ssyuXEiLQc1CZ3Twx+m3z
GJ8HMqC9KoRCrgqOUNwuew200cXKKpv5+su2bfvHdk+/HTbl7i/Z4Dv/0tau2+g0D287QCgGjTb+UJG

WULKXwvyjDoSCtMRRG/x8AEKxVxs4cGDNNaUjkEB96unaY2QP5gFSMd/sV5n/giOUwJ6Hwag8u95Orv
ozu1B+wi5cbmOTn3rHSntNcC+7MkBoHx/phFYC60N5yteQcxxVPx2YSNzmeAvVr/pS3xA6CjqfCPX8D+

+3G/udcmXHqu+xJ78fvymRKSASlg6aye2fgjEvWELpts+cOmrnds20E5v/0c5XXLTi0mHWZthfWGm3Q
U6VQypMObmaAWm1RzhlSwOZfeQLaDhMSDk21Ib+sLu1t/Ph9++DfK6JwCT6oEz1SSuQRyCtMu4Ns3
Thrx+w+0clHnAvPPqv7f4nfu4eAezcudNpaV7O5cEujgi8ijzwjZEAhGJxw+PLvLKXKiinhA8JXpviDlbZ8TZr
02WclbQvskvn9tq1k3Ns5IihTjuhBXiASmDPgpmFh4vBw6WOJ5CAcCOgCCqEE+kYdHmBIBZEYhIImIm
QiTo8ICRPk6SYOpQRSJOvoIfGBIiJ1mX/5gfyKFM510BfXEcqcM8ICX/a8vrrr9tNN93kjhctWpSsEUNgXpl
DjWnBaijArSMou3ftsIqji6z4+L8EG/TTVtWmh42f+r+s2+D7AgG87ATR1yK0Q9ilcThGKzGgmADUJV8ko
B4ahWOIpyGXlqIvYtr5pprq0ZY0dbQQqAyQJkgz+mU1C0cyFrg++tu89AXr3D7xKtTVkuE26pavuDTg+

mbOnGnf+c53kjkxfGhhk/vcmeDB4Bc0oVjFIUH5uVNWvuc3dm7n/7OKS9VWNvA+G/uvfmzFHXonaye
EMLyyI5QMqohBWg9tpVEgFDECj+ZCuEUc6pBHv8ScwyeNCKJp4jhMDpWrrl8OGf026odzcc0xsoesB17
xIsYkLliTT0Cw0Qw9evWzYZP+k5V0HW0lbQPNdWiF7d84y65eqXSCRz0GDdIg/Bwj/ASEU8eYfMQIrvZN
BEiLUNOXSEVA69Ev7TmWwAMdE1OuOgJlqq8yYkCaINJo36X+YuQOFmO9WqY38wuaUAgWwg5BCNX
WwfpP+ltr07ajFdtFO398nVVXnqoRQognDYXgikgILeUQSWn1q2O0FjGrmtpzTN/0A6gvkihQB4TzmTxIS
hwu8+vL1MRs9a81Ru5gTHmLhPcy9cOqBa+hAIKHsDlitR9s/Sd838p632zdeo+ytu0Tv6BEOcLJoEEsBF

MCCzimHkQSWSgjH0AoVjSOZRqKQIA07WlDmaByQJ8K9KNzAYgqE1MEgnCkydP5YuQPOKd4vYw5YO4
Y44LeQwGEW6s3gorQF7W5alcuHLX2JZ2sQ9mgoFaRE1aEHSEG1EeoaSP4aYYVzxomHYJMXTaumAbUE
0lJU49jaTzaqm/SxATANfjHAvU4j8hEf5CY+vQJyCMA+ifEyB4QSIsjY4mMFDyhGAzczlrtGRRf2AFDxMAR
U18ayhdsYsoJSkNOVjCEGiDs9E97yEMd+oFQMifJ1/kpBzoH4PyUiSThOvRBHfrRdagv1SHNOWJC5QbG
mYAloDkpeJNPAslgIHByKgA9uwGUkc+qLzIpH6gfQNoPACLRjva+ycdkSLDpi2OISBlQe8XU9cmkfIFyyEl
fBNX1rzOqXYzswLiyGDOfICZUIFi+8KFNEGiIRB4kggCU+YLIAJKmvoKgtF/mtydNn0yEhF9EQKPJVINUM
jWpj4ZTvn/NQNflQ3UFvw5tY+QOzSdzWfAmH7eOucefIzAgCDOmEoJImS+QEnqIREw9QD0Jp4aSYwg

AKdkzKV/tKYe01GGPBWkJ0lqUc8xEQSIC/XA91CGfQD00GnUho8il6wnDvz6uhRAje2iBIzCmbm6SZQU
LBkIvNiLkDAorDYOFwCPgCCICC4mIOaYeA4lAc0ygLwkzZUDCD+iPfPrUK0qqBziG2BBE/RDTjgABdB0iB
IR07trkOaLAtfnn4ThG7kAGJAfMKfMSvykRkAgBBrx9LnMLSIgFCTqDJ6JJCwnkM8jUI+b5BO3I18DTTn1
ABupCJOUBEUp9iUD0oWNAWlNITDnkUnugtOr5/cXIHiy6gHElMJ4FTSgIw1NuVhaGAW2DAEuoJbwIKH
UBgi8tAiTASgv0w4BDGJ+kiinn3GhH8pgMziHtg5YEOg/1KaMuZirmKdfB9RH8aSTt5xOHERMqdzAn/pyD
giYUAi1I6CATwoxpRR4DRh7C6wuqL6TkExhgIEGlf/K0T6KN6qoMwhFTLmJDLGLti2hHHdVTTBnXJkJTT2
na6xqV9vNiQuUO5gH58Me1oAnFSg8YDAkoQEgRagaLfL/Mh4SUegwukBahDHMQLUUe/dGHCCTi6jy8q

UweaQJp6qGJJPicizbSTEBxOuiaVD8mVO7QPAqOWIVKKASMPRNaAMFCSGPEqA8gFAuiYmTq88tugcDf
OxXomhIjR0Ai9t2yPrBkClJDccs8e4JQaCcGI9ZQLQMS1/qYugAtQhvmOqot/VIHgmCWC9oWAO2FdQ3U

J02eUJCEYh/iDzDA9IvRNKiPCFKXoHlLBdVR38w3j0ggS1RbyvlRT/76lj/JYDuAB5bfWhw7dmyNo4pF2N9
T0z+kJbh8l1tgYHAgkzblWsWEfScP23+d/Q82a9W8ZE40Vu/dbH/YutL+/LfPuDZRuFB50dUBi3estoXbV
7l0GP84/xUXXw02uS8te8elfby3frHrCywK+kjVj8C5Tpafcem1+7fYX772M/vNkrdsy+HdVnE50U9zh8jjB
8DcKV0XqENdgqyRqHbkQRACpKAev6fBx+74HREee2DB8FNhpCnXYqz+yXOhED4W4IPBwzOjgRB8tf2r

hbPsrx/5E7t54Ej7P/NetBPlpx0pthzZY2+vW2DDeg+0bp262Pyty23ToV32t49Nt4Nnj9nxoN6ynevs90H
d+VuW29FPT9naA9ussqrSRvYdYvtOHLIF21fbvlOH7UAQBnbra6v2brKhvQbY//3wRbt71AR7Z90f7GTF
OTt5/oy9vOI9u2XwGPv5/JftyNkT1rushz0XpCFdl5JS1+dvl79nq/Zttp1H99s7axdaaUmHgHwfufNOGjHe
KiovBQT82P582vfc/b4flP3TojesJBAwcOr8OevVpZtLNxVSkUNzFBVUngqU0S8B7cOiCanYO0eZ99RnoeX
3DgGmHiaeyCPNRFrnFRE5ph4oSA3FKoPqZ2AJvrl3PFjVe3dJfBkQwe1X1tNpotMXyu3mASOsd+fu1r9rb
9t9/BMb02eY/fsHHrcf/u4523xwl50JhPPg6WOBkJ61x+/6svXr2tMqLl6wso6dnVZoV9zWvjjmDtcHBJm3
eYkjBXhw7GSbt2mpnQ/q9ehUZueC8/3Zl79nf/Pms/bkXdPspuDcb61dYFPGTLT1n2x3fQGIDZl2nzho06

d+y34ZLAaj+gxy52GiIe7wYAEAZ4Pr45oeHvcFO/HpGVu3f5sN6n79kzhNBWmHcJDwRgXKMwFmHvsiy
ILQyxvnI7zIQip+2x1AJIhFrD2T2usaRFzyC45Q3Hhd6BtogctXKm1mYB795qPZdjrQFp07llpRMNA0hRxr
920N6vWyUxVnbemONda9Y1lQXmQ7ju23vacPJXsya1+U0AJVV6/UaIR1B3c4rTZx+LhAO222Ad0SPwL
ToX2JXQrO+/D4e116b2BCvrH6Axs3cLQt2LrC1gUk6tOle9BXpX3xhsQ3nCD/xoM7rUfnru76CF07dXWa

dPHONa7OHcNuDrTVVpu59O2AdIesU/sOAVnPW79uvezQ2eNW2iH7r4A0NSTIqQLkIGYBZdF0Au+RAH
LxrFDPCynjeSAfjMC8o71emKaMNoB8wc9zIcioW8JaEeq6VX+QMsWslXPtsUlTrbio7gekr66YY09Mvv7zX
GDFrg2BNrpgU8d/IZnTuHgtuPbbho610f0SGrIlgvlUSKWx+Js2zDxIhYYh7ZOLtsw95cQco80ol/Wic0jLy

bzzoX5iQiWRDaFywbmL55251lRo6vPnA/58SqDDgAR47PDgsQdC82Du+3tmNBSaSO3VF8E/B1oMokE
ykdEvBzmZfG+u/tD++9u/sPOXLiRzPo8r167a8t3rnRfrnxe9mcz9PBZsXeX2LODZeS+5OAzqsHcB87ess
OOfnnZp4VLV5WAfsix5lLofHzgZNDAXgw08e53KK8EK9VltOzvfaGphbulkyhSQgr8G4K1/Yn2EDi0DKQik
IYrkQNouTBY0lv5cB/gERPvxbDNrL9976xfZmH5Dnclz4NQRe2HJbHeCt9b+wfYHG+E1+7bYhCE32gebP
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gqE06xnaVf7ozsfciQc3LO//dOi123lnk12OLDj39uwKLD1x9qKvRvthv7Dbe7GJbYh2DOcCvYvpe07ur3Gi
GCjvWzXumBvccjGDhgZkPMNG9ZroM1c9nZA6Aq7UHk52HN86PYIbNppz/7n3jG329Fzp+z5Ba+6/c+s

VXNtxe6Nbg/BvqIqsKPvGD42IGOl27uUtGsfLAKBbR2QE4Kz+WcP1DZCzcdoXpCA+0DYlQ+RpJl8UpAn
75/fh19H/aClREi9b4lZyfMrp7lciyywN9jgju6X+DJFVXXC+4F7dlTfIXb07Em7ZfANrgy37YM3T7YLgYA+/

4dXbefxA05ANwcbczxXbMS/N+UxW7h9tXMGAIR3+tSn7ODpo7Zox8d27NOTLr9dcCPtgrIPNi+1cYNG2
TvrFtoPHv5jt7n+eN9m+3f3/ZEdOnPcTgSa62T5WbdHAdeC6+vYtsQWbltlDFGP0i72wuLZNmPqt2o25W
gkHAvgavW1YF9UZB3alTSKtoqRGyT4UVAZjgVpITQQ5BB5iMnzX3QFqiMyAUgDqdBUkBAy0S+eQMzLr
An1lQlftJ/N+xf77Yr37fVg1R/aM/HxL04+PNAmS3Zd/4IfZtr5y4EWqbpkndp1sLmbliRLEuQBVwKmty9O
eMLOVJQHZFnkNMq+QCPxnEaYdut9tisg5Zh+w93zkzfXfBiYfmccMd8NNB2kuxYQ4AujbrUuHRKf5Jz98
XznOubaigPSEKN50LJHz51MHAftLgTkx2wEwVAGgxjYzVerrH3bxHXFaH5g7oAEPhV8R4La+BBRAOWqA
1l8+OYhJEWrsSeTe73BnRKfBFqGgOlVF1YGZljPgCBoOAHt8MsFs2zGQ99K5uQGf3DCt+0PuIBmwhQsL

bnuWmZVoh82sakgr1IYPBOpq12M+kFzSJyKULjGBbQKgh811wDnhD9v0k4+mFvyqUeZPIKYfo1CqFw
AoYK1wple+QC3SggPPnnaiILf/e537vM1+/bts1OnTtmjjz7qPtqM7QwptCrxuRt+KJ48BvPEiRPug88PPfS
QmzwGmY9e8/rKnXfeaT/60Y/cJ0RvuOEGGz9+vDuP3ljmO0z8ECaAdNjknHP69OnuK4oxPg+JLgLtz58P
n1DUZ678nyzwgclHfbSVLyM6D9DH1fy9GO1wSDT770PhIMgXmYAGxh8gECYYBIAcx44dcwOFYPPRZjx
FDB6EYqXjg2TUmzNnjlup+FA15OPDztSBbLt27bI1axIPWcnjKfzKlSvdCkd/tNuzZ4/7UDZlfPSaj2MzaXx
3aujQoa5tjOzAXGu+pXHC8y9Q7lsxYTBX4ZdraUNgbl066Dy691aI8GAxAIAhiFrhGECE+5577knm5A4I

w3lvvfXWZM51vPLKK06Doc1ipAfzpjnV/JGneQW+hgIc0wYtJNFXffLZR7FYRnkDKasx7TzZQeshK+7tiiCj
IAjFbdZ1q6lMhhjNF5pTQqaEArz46pt91JdsQAzaoInCey05LXyTEBKy9+IYq6NgpEgDBjQJSsdoufDJA8L
HYfjzTl3V92PMekjCGxY4IdBApCEUxA23AZCPPhuEUFwAF8VmOxWoEwWp1XwiijT+oMSkatlgDmX6MZ
d1zSd1/fpRoBwNhWlHX5h/8uqpneTGPyadtcnHt2k/+ugjpyKPHz9uY8aMsYkTJ9r777/vLoDNOJ4rAm/w
LliwwG3CAZt0Hojdf//97o+48Gphf/Kl8RUrVtju3budZ4sb4s1f+uIceNXmzZtnd999t/OeTZ482fWXDtxi+
DY1IEoTYrQsaP40v5pDfy6jTD4WevJx/PhgIceLhzzKfe7LCO3QUHJAUIbigAPko6Wy1lB4oOiAE/N1cDxU
EIk/HyYfgnBCLnzp0qWuzfbt251njDxsWDxoeLy4UD7lj9sYlnNx7777rrux/v37u5vkLyjJGzlypGsH8XKFBl

6DFqNlgnnUHioTyCEBGYDkgBiyoJ107Jt4lGmPRVtklX7IA+TlxSmB9kG75AtcGJ/zf+KJJ5I5ibxZs2bZk08
+mczJHLrF8K0yUMpLNSEMFvXw/MRoXogSXT+PeUP4JfhyMpBmywFx5M2jDhqK+fYdFupPpEIO9XAfC
wplQB36Il3QXr5UhELb/vrXv3YubAaNgYbc7O94tlQnmvy9v2Dik5Pf2qG5I5bAM498jV15EABScYyGURu
cDFhRgt7JQ3tJQwH148cQB0LSHySlDedFTmJCJfN8Qj3zzDPu+dMjjzziTFoG6vHHH0+WpkFzeJE2+ZJva
wcEEPy5BEpDKD+ferTj76PYtgA0DkFvQKSyVgB9seVAi9EPhCJwHmfNBBVqS1krhW6TmMDApiJUTkgS6
tCmc3ZoQ+JXhxobwd0lU+lx+6NDrX1p9Ltt2YOxTSYbEJpLwFwKml9iFkPl4QrH4gA41QDl0jLhZ1OC+g
PUR0PJ60c+ROLZlns+FWQWHKEEDTqIIhRqnb0T9bSHSjdcQY8uXvHiXlv4850u3diohlB1X2YNvj/7fivre

93EyQuC018Xx2j4ApstwnMa7hMNguaBMMwvWoQ09XGAYdrpZWXaqj3lBL8/pZEJyjD3IBamIkSSdsuZ
ULCTi2V/oYtrjtBtEhM0gAw6sU8oXPn83SWOFjyMuOgx+ZiQVM/PapDUUOtmHbHl/7zfpRsb9SHU0zMn

Wefe+XW4IHu+MDYU/LkUmEdpGsrwKiPwaCaZc8w52opFEmII1Afqzz8m7e+dpNkoo1+nnYJ01oTioj7
88EPbu3evsymHDBni3kHjuRMXK1XbXKDbJCa4m08OFIE3hYWf/vSn7lHAN77xjRoXf8Z7KCfJnzWhhuK
epCfToyE0FOIYDG3GYB4yhV8XGWTutBiSFlRPGoV5ROgRfi2MmG0+ocKgf99FThrQD9oNJYIGRJGIrDlp
qDfffNN1xjMk/tyBB668ld0cCQW41VS363t8VM+fvMwnPSYUI1UPjtRjbGvXRcgBeeH5EljsEX4E35lkQR2

sKrnHRQSBfiAOZKF/n3BoJPVBOeYepNTLtDkTig7pHMbmzeS7tNfsWhqzKkuEb1XHxMVdbnZpoMFksJzn
JrjHzJ9D1ZNQbXgOUg/pywBNvYdCrqOEO9/w55N01DmRUeYOkmCyMZ/MK2kWfRZSjklDOmLqI9MQh
DR9Iw/EjjTBefASSuORp5A1ofCSvPPOO67T/fv31zL5csLOH5id/Sh5kH9wuwQGxb/1ojs+SKYS9zZ37lw
3iHoOJZMv3WAFuzIXZ0yott2CRvndwxSaU6IuoKFEDkjEnhhrivNzjHdOmkiOBfqlPqAe5ciAnBssuDzH4u
0d8kUmQk6EwuTT7535Jh8PPzlpNuh99u+s5GLdP4SfC7hdBR/FE69/GOB0cG9vv/WWG2StXhCKe0r7Y
DdJqK1vn7a1Lx516bpQXVQWyH7iaX1egADUY0af+lmpdbmyOXmUH0CVfBDGR2XfyXatY58aQQcIevg
8CD2vq2l++Ytr5lCmG8e8U0o5WxNIBTEo97UQUB/Eymc/hcyj2ZB7ZAO5IJ90TiYfyLuXrxE0lAbOnwyfU

FFDkrmAtCwNNePZSita+VfJozwhOD0/C51PlDw604r635Y8SoB5BJqb8LyRjyYhHy2FwPMX1pCBMgKkg
mCUR4G26hc5pz9IiymI7MvZIS2YE6Feeukl13lLMvkAqwm3rZUI+CZfbqgfoa4UdbOqq/kVvurPMu+vIQi
FfAfimjyqjaKiNtaxff0fJEcRqi7RVRkmH4A8EIp8TDvmnjQmIJom/FCXMsVK0x4CQh7IpLcr0IBC1oSiY94i
37lzp+u8pZh8gJVN5oIG1icU1646rETUI84M9SPU5c+62vnLiTZ5gROCICQP06FBCEVIwemStkVWWpId

oYoH3F5rEdQcRokw+QBCyTTTnEICtRPJMPnUj9pSFzj5CM4LgXC3y9tHulevXu5YbXI2+fKORtBQ3LICA
+HC7XOTpYn94XPPPedejvUf7DbEHqrSuln5pdo/sJgTnKBkTqin/+6Udd/6P5JH+UGdhGpXbGUd62/inp/
y91bV/abkUQJYGoIIgqCzh9IxCz+ADHj8IA5/YkSZD8mC0gImHQqDvRakYltDOQFZ4HyQSgvvdbpnCU4

Gy2FrS0PUAAr8YSP5vjpH1fPHknWHwS4knms50UofuI58Bddn4t9MQjdW64j8nAL/5BkIbXis2WYMHjzY
xTrmF6s0r8SQjhiTDo8t2smfb78ukBZDptFuLK6QkRdppdlYZCmHuPRJubRZThrq+eefd6ync38PxapAXjY
oPfTXVnz++g/+NxS4bQZBA5lqD6XhUb1gbXJxOmRq8lV+1i2/Jl890SBOiTpQ0q7IOneo7dXU2NYF7aH
8upob4lR9aKFnrnFIsDUJOyBEIMVoJfrjgTAaDRmHOGgo6nCMxpKmg3SUsQhnraF45Wjx4sXugnWB2JIt
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BQyYJiE8GZh2rDqAwfUXBzbb+fyP/wsqJP7JK1KRCWHHFNP+FxLITKQM64rFHxkm4MFD+0AONBpkom
/kGpkgTRlWizyFMgPVT04aCmZyYjrlhC3Bbe6D1QYwMP4eihcq+eFJ7s9/sJvZHiqBeu2hLudxD1VPNMQe

qi7kcw+l+fOB8GP2CSyIig8fPlxDFEBdZFfkgijMMUBJqJ72UchCFHnVnuvJiVC8TcCvnvK0uSW5zQV/Qny
Tjx+fYWAxERhkCMWLsvVBxiZfExOq8U2+7AiVyXOoKEAGApqJ+WQfJBc5ZHKLaRDYL+kFaShBIF/0QA

Y49r29qiNwnLXJx80gbLA2bPKh/lCf2YRrV5tOuIQpU6bYgw8+aE899ZT7aeX6kqk+yHRP1moQ3C6y4wc
JcCYhClF9CdIcmPDsifDKQQpikSlMCuCXiXiQyu/bbwdc/aBC9FU2FRpRQwF5gfL3HCqBJtNQwWwGIvW5
yU6FlqyhEF2C7jVK2FncSbNYM4dop6ix4XUi/094AERCPiASygJNJzKCKOrk5DZnj8EKwAnlTWlpYNDC4K
85f/WrX7mvYxDPnj07WdL8AZkKBRLouogl4YcQ5EMQv1ygnhwWgL6oB4lYYHWsOlGkJC9rDQXzt2zZ4n
7MBPb7e6jm/qZEGAyB75RgD8U9cI8MKKsaZh/3lG+nhHtTojJ/bvPPqpOC9fn5jkSjOyWyfFMCp8SVHm
NrLYBYED64b8p5PqRj5o9FHxlla8I2RSTzgQcQUAd5oB9i2sp5geLgnKoDRKyaOCjImlD88CQqkHf5/FePc
kIjm3yAIfAJlQ80lckXnuh0aA1Oibqgh7AQg5dg5bkLg76wsuSwYPzUv5OP4JhAHfZiEEx5PrI2+XBG4Eqe

Nm2azZgxw7761a/mTqYmQnhQWjKCKU6mCgf+/EnIFRB8iAEJQCr9QT3f5BOJyONBrkA9aTPKfbhzBg2
z0lDgtddec+qTF2RbssnncNucZKI2WNkYqIZySuTb5Gv2Tok8vhyL6ErwUwE5xNyjHkoA8w2NhdkWbofr
PPHKWIIc6h9ScSythNZzXyv0rkXIiVDsn3BMhH9TIic0gcnn4BGKjxOwKPA2SEt8sMuU1iVkPlr6g93wfUIY
7aGA9k/MHfsnNFWqxZF6vhfQpwZ5BPJ4nsVrRvQTPn/e3ObYli3tTYla8AgFgXitik+CtrgHu8xmZlxyaC17
qLBgC5hnPINCPlkcRZioRQe/ACQhhMkkiFD0EyXveSEU35TlA89f+tKXnKbKCQeeCdi5I3nQiBj9v5OJ/CB
TQlVZqV2sysualhUam1DtigOTL/RybCaIIhSmmIgRZX5RhtbB0ydCYdJRl0Uy7O2jHoF6gvoXOGZPhcbjT

+fDpMwLoXCf8+3YqVOnOkLxd/vZ7qGaCvzAfBhMgtR6KjMhFTIlVFOjsQkVhbBQRkGE8okjQmlvI0ikiXm
mqDfGqcfeh7mEUJiHfjs0HhrNJ1QY9EnQb6M3CKFaG9hD8dfIDHz9/8AwgUz3UE2Nxt5DZYtUeyiJrwRbe
ygdo6EgFERhLvWDLJiB1JX3D9AfZp9c5z44D33qfFGOCVcn+CcmVAisXvxEGhrKf7BbH8QaKr+IMvkQX
QJEgBw+nHAHBEAzUcac8hVM9sS8IMu8kvYtD/qBaNJQIiUQTXQ+iIqGxDkBcH5Axs8bnjGcbc1Lsd/+9rf
tu9/9bsO+HJsUihj1hz9u4TEUGSASZSIOMVoJLQXR/PGnDQHChAF50HKQRl/aQDth+kFa2qH9YkKlAQP
YkNAkxsgNIobIIUAggvZZpKkT3ncBjllMISGgHiSCMMSQiva8cYEWI2Yfhemn51oxoerACy+84P7m69VX
X03m5BeshJgKmB9hQYiRHiKET44wSaRtGGdpFQhDvu8lFEhTRoBIzA0kQ6vhJkezqT4ajv5Unz12vIdKA

R5Y88V5wCA+9thjeXdKMKFMNBPGytcUaMlOCYmuL8IIue+UwMJgfHEiMNZoFuoz3tIqHEMMAIEIHDPfz
BF7LgBpKEMeSEMyyMk5yaOfmFANhEycEmyAmZC6nt43NFq6U0IxAu7viSAEMVoGIkEM8moEPyCS6g
B5++iHeYGImHLEEA8iQkz1zT6KY/ph7jg3iE2+JoYmNEb2QKgJkMFPA7QMgi/nhLQJdSAa5CGmvk80PI
B+fUijMoDWgqSUi0wgJlQaMOANJfThyYiRPUSkcFrEQvgx1xQzp9oXAY4pkwkHodBKaCnSUeBxStiyiE2+
NOALI0zAE0884dQ8D30zwdXKYILSvEXOBGoFZRVsCpR0ClbZ6sSfIzRnVLcL9j7uW1rXIbJAHokxAj5+/
HiXBjwvYnwZZxZHCARRaMu8Ajx40mJ47khLE9UXMaHSYM6cOc6O/vrXv57MqY2o4dPq6IN64fzmQKiW
DBEqDH+cGV9pJkgCwdA6HBPYHxEzP2gijnNBTKhGhE8q0ppoVlVIFaN+kOiGRdgfY7QOgUURU07HmHt

oJghEPWIIlasJHu+hGhH+RAOIxEQ21T6KP09ZtWqV+2HPlogwkYCvnUhTh8AYYwXobXM5I3i9jDnQvip
XxIRqAjDR4dAU4JnamjVrHLFaIkQWoDEMkwJtRJ72UaRZyPDSoZF4Fw9CyfTOFTGhmhhNRSaAcOmrEi

0R/oLkE8nfW6GNfE+czGxiCERdjjEB6YN0LogJlScwGUwOcSYhXFcTS5CdT9qvRzrVOVTml6sv9UPQORR
YmYn9vuoKfv/5DH6/6c6he4lajCj387k/AsTSHkkOINJoJ4jFoiJy5oKYUHmCJoIJTQV/wsITxzGTTmCiielLg
u/3W9c5wmXqV+fWOQjsI/jDUP7aGgFNB/oOX3c+keq+lK9r1DWE6+vYv0btUYkJkApthOucGHJBKOoA
xiUXxF6+PIKhJEQJXSpBrKuNoBXZR1Qb8oCfL/JEYcOGDe6vrSdOnGgjR450eX5d+lGfwO/XP3+6688U

Oleq/sLnBDomVnlU28ZCrKGaGJkIAEKuVVQhfKw8P590KjIhfLwwipcLUB+EiavrC1+jjqOEX8IOSOvYTwt
+meCf0w8qC0N53GtUeWMiJlQe4U9mWHjCguQjUyEI1+M4HASlo86ra8Pk4WffcEwAn1SEuq5Z8M8ph
K9Dx346k76BrhXQVoRXX35oDohNvjxDAsAEKxbqmvTwNITbCqnyBfWTrg7lxDzchEj+mxrkI7jUYdVPd8
5c4F+Lj1Tni6rXUNeWDWIN1YDIZaL9tgiRQjpkck7VwRnBH0/ycBdPmEC5iESI6tO/JoVsQN/htnXdA2V+
m7rqNgViQuUZYQHJVNAyESKFVPCFLN15eUvg4MGD7u+F9CfcPnSeVP2Er4d6aDV5JWWaZQL/etVfOjS
H/VIUYkI1ALS6g+Y46QATD1LxK6i85xYFX9BTgXIRyK/LMQ9PMyEW7ThXeKzUH3FUPzGhCgQSDl/AQP
g4n5BQ1gf8Sg9/rpCqne4hFSlUxgIS9jqSByjPhFRR1+CPoV9OOqp+08Ps/wMvoEIi0PKlZAAAAABJRU5E

rkJggg==</Image></Frame><LayersContent><?xml version="1.0" encoding="utf-
16"?><SerializedLayerManager xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" PlayFromIsNull="true" 
PlayFromTicks="0" PlayToIsNull="true" PlayToTicks="0" DataScale="NaN" DimnScale="NaN" 

xmlns="http://microsoft.data.visualization.geo3d/1.0"><LayerDefinitions><LayerDefinition 
Name="Layer 1" Guid="3f1c55e6-aee3-4d0e-b211-eb4903e561f2" Rev="5" RevGuid="4a3a0bb5-
d2eb-43f6-a6f0-61328034fdfd" Visible="true" InstOnly="false" GeoDataGuid="dae80666-9362-

4607-a2c6-511d76749d59"><GeoVis Visible="true" LayerColorSet="false" 
RegionShadingModeSet="false" RegionShadingMode="Global" VisualType="StackedColumnChart" 
Nulls="false" Zeros="true" Negatives="true" VisualShape="Square" LayerShapeSet="false" 
LayerShape="InvertedPyramid" 
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HiddenMeasure="false"><LockedViewScales><LockedViewScale>NaN</LockedViewScale><Locked
ViewScale>NaN</LockedViewScale><LockedViewScale>NaN</LockedViewScale><LockedViewScale

>NaN</LockedViewScale></LockedViewScales><LayerColor><R>0</R><G>0</G><B>0</B><A
>0</A></LayerColor><ColorIndices><ColorIndex>0</ColorIndex><ColorIndex>1</ColorIndex>

<ColorIndex>2</ColorIndex><ColorIndex>3</ColorIndex></ColorIndices><GeoFieldWellDefinitio
n Accumulate="false" Decay="None" DecayTimeIsNull="true" DecayTimeTicks="0" 
VMTimeAccumulate="false" VMTimePersist="false" UserNotMapBy="true" SelTimeStg="None" 
ChoosingGeoFields="false"><GeoEntity Name="GeoEntity" 
Visible="false"><GeoColumns><GeoColumn Name="City" Visible="true" DataType="String" 
ModelQueryName="'Table1'[City]"><Table ModelName="Table1" NameInSource="Table1" 
Visible="true" LastRefresh="0001-01-01T00:00:00" /></GeoColumn><GeoColumn 

Name="Country" Visible="true" DataType="String" ModelQueryName="'Table1'[Country]"><Table 
ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></GeoColumn></GeoColumns><Locality Name="City" Visible="true" DataType="String" 
ModelQueryName="'Table1'[City]"><Table ModelName="Table1" NameInSource="Table1" 
Visible="true" LastRefresh="0001-01-01T00:00:00" /></Locality><Country Name="Country" 
Visible="true" DataType="String" ModelQueryName="'Table1'[Country]"><Table 

ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></Country></GeoEntity><Measures><Measure Name="Cars" Visible="true" DataType="Long" 
ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" 
Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></Measure></Measures><MeasureAFs><AggregationFunction>Sum</AggregationFunction></M
easureAFs><Category Name="Model" Visible="true" DataType="String" 
ModelQueryName="'Table1'[Model]"><Table ModelName="Table1" NameInSource="Table1" 

Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></Category><ColorAF>None</ColorAF><ChosenFields 
/><ChunkBy>None</ChunkBy><ChosenGeoMappings><GeoMappingType>City</GeoMappingType
><GeoMappingType>Country</GeoMappingType></ChosenGeoMappings></GeoFieldWellDefinition
><Properties><InstanceProperty 
InstanceId="LatLatValLonLonValAddrAddrValAdAdValAd2Ad2ValCountry'Table1'[Country]CountryVal
USALoc'Table1'[City]LocValSeattleZipZipValFullAddrFullAddrValOldOldValCat'Table1'[Model]CatValFo

rdMsr'Table1'[Cars]MsrAFSumMsrValMsrCalcFnAnyMeasFALSEAnyCatValFALSE#"><Annotation><Ba
ckgroundColor><A>0</A><R>0</R><G>0</G><B>0</B><ScA>0</ScA><ScR>0</ScR><ScG

>0</ScG><ScB>0</ScB></BackgroundColor><Title><FormatType>Static</FormatType><Text>
These are cars in Seattle </Text><TextTemplate>{0}: 
{1}</TextTemplate><FontSize>16</FontSize><FontFamily>Segoe 
UI</FontFamily><FontStyle>Normal</FontStyle><FontWeight>Normal</FontWeight><Color><A>

255</A><R>0</R><G>0</G><B>0</B><ScA>1</ScA><ScR>0</ScR><ScG>0</ScG><ScB>0
</ScB></Color></Title><TitleField>City</TitleField><TitleAF xsi:nil="true" 
/><Description><FormatType>Static</FormatType><FontSize>12</FontSize><FontFamily>Sego
e 
UI</FontFamily><FontStyle>Normal</FontStyle><FontWeight>Normal</FontWeight><Color><A>
255</A><R>0</R><G>0</G><B>0</B><ScA>1</ScA><ScR>0</ScR><ScG>0</ScG><ScB>0
</ScB></Color></Description><FieldFormat><FormatType>Template</FormatType><Text>Mode

l: Ford</Text><TextTemplate>{0}: 
{1}</TextTemplate><FontSize>12</FontSize><FontFamily>Segoe 
UI</FontFamily><FontStyle>Normal</FontStyle><FontWeight>Normal</FontWeight><Color><A>
255</A><R>0</R><G>0</G><B>0</B><ScA>1</ScA><ScR>0</ScR><ScG>0</ScG><ScB>0

</ScB></Color></FieldFormat><DescriptionType>Bound</DescriptionType><ImageSize>Medium
</ImageSize><NamesOfColumnsToDisplay><string>Cars</string><string>Model</string></Nam
esOfColumnsToDisplay><ColumnAggregationFunctions><AggregationFunction>Sum</AggregationF

unction><AggregationFunction xsi:nil="true" 
/></ColumnAggregationFunctions></Annotation><ColorSet>false</ColorSet><Color><R>0</R>
<G>0</G><B>0</B><A>0</A></Color></InstanceProperty></Properties><ChartVisualizations
><ChartVisualization Visible="true"><Type>Top</Type><ChartFieldWellDefinition><Category 
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Name="Model" Visible="true" DataType="String" ModelQueryName="'Table1'[Model]"><Table 
ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" 

/></Category><SerializableTableColumn Name="Cars" Visible="true" DataType="Long" 
ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" 

Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></SerializableTableColumn><CategoryValue>Ford</CategoryValue><Function>Sum</Function>
</ChartFieldWellDefinition><Id>1a268f53-c1bd-43be-a003-
252909957508</Id></ChartVisualization><ChartVisualization 
Visible="true"><Type>Top</Type><ChartFieldWellDefinition><Category Name="Model" 
Visible="true" DataType="String" ModelQueryName="'Table1'[Model]"><Table 
ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" 

/></Category><SerializableTableColumn Name="Cars" Visible="true" DataType="Long" 
ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" 
Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></SerializableTableColumn><CategoryValue>Toyta</CategoryValue><Function>Sum</Function
></ChartFieldWellDefinition><Id>7026d600-99e5-4e31-9ce3-
e666d74331f9</Id></ChartVisualization><ChartVisualization 

Visible="true"><Type>Top</Type><ChartFieldWellDefinition><Category Name="Model" 
Visible="true" DataType="String" ModelQueryName="'Table1'[Model]"><Table 
ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></Category><SerializableTableColumn Name="Cars" Visible="true" DataType="Long" 
ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" 
Visible="true" LastRefresh="0001-01-01T00:00:00" 
/></SerializableTableColumn><CategoryValue>Peugeot</CategoryValue><Function>Sum</Functi

on></ChartFieldWellDefinition><Id>feff13e3-65c6-402e-a08e-
6741cecc1a28</Id></ChartVisualization></ChartVisualizations><OpacityFactors><OpacityFactor>
1</OpacityFactor><OpacityFactor>1</OpacityFactor><OpacityFactor>1</OpacityFactor><Opacity
Factor>1</OpacityFactor></OpacityFactors><DataScales><DataScale>1</DataScale><DataScale
>1</DataScale><DataScale>1</DataScale><DataScale>1</DataScale></DataScales><DimnScal
es><DimnScale>1</DimnScale><DimnScale>1</DimnScale><DimnScale>1</DimnScale><Dimn
Scale>1</DimnScale></DimnScales></GeoVis></LayerDefinition></LayerDefinitions><Decorator

s><Decorator><X>584</X><Y>12</Y><DistanceToNearestCornerX>12</DistanceToNearestCorn
erX><DistanceToNearestCornerY>12</DistanceToNearestCornerY><ZOrder>0</ZOrder><Width>

400</Width><Height>250</Height><ActualWidth>400</ActualWidth><ActualHeight>250</Actua
lHeight><IsVisible>true</IsVisible><SetFocusOnLoadView>false</SetFocusOnLoadView><Legend
><LayerId>3f1c55e6-aee3-4d0e-b211-
eb4903e561f2</LayerId><Minimum>350</Minimum><Maximum>650</Maximum></Legend><D

ock>TopRight</Dock></Decorator><Decorator><X>298</X><Y>215.5</Y><DistanceToNearest
CornerX>298</DistanceToNearestCornerX><DistanceToNearestCornerY>215.5</DistanceToNeares
tCornerY><ZOrder>1</ZOrder><Width>470</Width><Height>288</Height><ActualWidth>470<
/ActualWidth><ActualHeight>288</ActualHeight><IsVisible>true</IsVisible><SetFocusOnLoadVie
w>false</SetFocusOnLoadView><Chart><Type>Top</Type><IsVisible>true</IsVisible><XYChart
Type>ColumnsClustered</XYChartType><IsClustered>true</IsClustered><IsBar>false</IsBar><L
ayerId>3f1c55e6-aee3-4d0e-b211-eb4903e561f2</LayerId><Id>1a268f53-c1bd-43be-a003-

252909957508</Id></Chart><Dock>TopLeft</Dock></Decorator><Decorator><X>42</X><Y>2
40.5</Y><DistanceToNearestCornerX>42</DistanceToNearestCornerX><DistanceToNearestCorner
Y>107.5</DistanceToNearestCornerY><ZOrder>2</ZOrder><Width>792</Width><Height>333</
Height><ActualWidth>792</ActualWidth><ActualHeight>333</ActualHeight><IsVisible>true</IsV

isible><SetFocusOnLoadView>false</SetFocusOnLoadView><Chart><Type>Top</Type><IsVisible
>true</IsVisible><XYChartType>ColumnsClustered</XYChartType><IsClustered>true</IsClustere
d><IsBar>false</IsBar><LayerId>3f1c55e6-aee3-4d0e-b211-

eb4903e561f2</LayerId><Id>7026d600-99e5-4e31-9ce3-
e666d74331f9</Id></Chart><Dock>BottomLeft</Dock></Decorator><Decorator><X>298</X>
<Y>215.5</Y><DistanceToNearestCornerX>298</DistanceToNearestCornerX><DistanceToNearest
CornerY>215.5</DistanceToNearestCornerY><ZOrder>3</ZOrder><Width>578</Width><Height
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>426</Height><ActualWidth>578</ActualWidth><ActualHeight>426</ActualHeight><IsVisible>tr
ue</IsVisible><SetFocusOnLoadView>false</SetFocusOnLoadView><Chart><Type>Top</Type><

IsVisible>true</IsVisible><XYChartType>ColumnsClustered</XYChartType><IsClustered>true</Is
Clustered><IsBar>false</IsBar><LayerId>3f1c55e6-aee3-4d0e-b211-

eb4903e561f2</LayerId><Id>feff13e3-65c6-402e-a08e-
6741cecc1a28</Id></Chart><Dock>TopLeft</Dock></Decorator></Decorators></SerializedLaye
rManager></LayersContent></Scene></Scenes></Tour> 

<?xml version="1.0" encoding="UTF-16"?> 

<Visualization xmlns="http://microsoft.data.visualization.Client.Excel/1.0" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema"><Tours><Tour MinXmlVer="1" XmlVer="1" 

TourId="ec60d2e0-507a-474e-9274-6cfa4a58f6f7" Id="{E2F97C41-C1C2-49B9-9FF4-
4D1B3A9A3911}" Name="Tour 1"><Description>Some description for the tour goes 
here</Description><Image>iVBORw0KGgoAAAANSUhEUgAAANQAAAB1CAYAAAA2ns9TAAAAAXNSR
0IArs4c6QAAAARnQU1BAACxjwv8YQUAAAAJcEhZcwAAAyQAAAMkAbQeFOYAAC2qSURBVHhe7Z0JkB
3Fmec/dUtqSS217vs+ASEhDgmEQQbWCOxQLDZ4DBh7Gdu7sTHrlTbCE7MzOzETs/asd7wHjvEugwfb

M8Y7AgwIkDklhGUd6Ba671tC9y1araNbUrP1y/f+reyiXr/X770+X/0hlVl5VVXm98/vy6+qX7X5LIC1Ely7

ds0qKyuNW2rXrp21bdvWioqK3PHly5etvLzcHbdp08bFlAOOFaqrq+3SpUuufYcOHVye6gich0C/5Kufq1e
vunRxcbE7joKGWzHXkQlUH1y4cME6d+5cK8+/vlRQfepyjf51btmyxc6cOWNTpkxJ5sRIB2TgypUrbs5rZ
CkY5Ouz0sJx8eJFq6qqcoTo1q1bDSG46fPnzzuBBwxESUmJGwQRTOAYUgHyw4Eyhoy+lKYfYgJEFEmoH
wZ11I7y8Pl9qE4Y3EuXLl1qzkmdVOcCKlN9zhkmVIz6A1ljbJGn9u3bu3HNbHlsIZBgl5WV1dIu586dqyEU
Gkw3T7kvdAoImoTODZJXl1h5aku/BI4J0l4KEMgnqd83x6kQLlN/gvqK6oM8BaB2fl6M3KC5ZS5ZxEm3K
kIhyFp1faFBa5SWljozCdKxskAyCTntAMIJGCjS5EMUYuqGhbNjx46unvoRsagnQfeDTzxAXqZQGyF8HAb
X5Nfxr4P8dO1jpAdjTEDmiNlStCqTDxw5csSZQwQfCDLaCbOQASCGZAg+xyIj5NNAUZ98hFDE4Vhp5as

e7dUHYGglwBLmfID9IPeHpk3Vp6Y1qpwyFhX6mLtknV26kqg7uHeZTRw3yqXDoD7ni3EdmnOAfCFTrY5
QaB5pIh8IREVFhdtPMRCQiVsnjaAwMBJ6yEI9yjEfmxu4ZhwI3bt3ryEOqA9hRf4Hpz9re6sHu7xpQ8rt2f/
ytL333nvuHAcPHnSmzJgxY9yYfO1rX3P1YiQAiYBkh4W1VZl8oFOnTrWETEBAuGm0BzGCAmkAwqKYQU
LrSAuh8Q4fPmyHDh2qyc9HwFPnJiB5DEFOnz5dqw7n514+/fRTV98vE7gXEYm6CrkAojIOjBnnPXv2rDN
vY9QG44McMY+MOY6uVqehuB0EUapYIF8BwUVbMRA9e/as8fahqSgnLU22detWGzJkiL377rt21113OW
cH7SAudTjXjTfeaPv373c2NBoNB0i/fv2cFmSVp08E8ujRo6588ODBzjzYvXu3M7vuuOMO+/3vf2+jRo1y
14WGPXHihBNmrg0yDx8+3F3fhAkTHIFOnjxpPXr0SN5dApxHEMlSQRpqynd/bAeu9nF5Xx5Rbb/80Z+4

dIz0YLxZeBhraalWR6i6gPDreRQDADHQWAg7gyEvIWmZfBs3brRx48bZW2+95coR8mHDhrnyzZs32y2
33OKI9sYbb7i8kSNHOsIi+JDlk08+ccKPKQqRqDNixAg3EWvXrnXn/+Y3v2l79uyxhQsXunPg8ofI9AXJN
mzY4FZCiPbkk0+6a48iFNB0ZkooyCrThf579erl0jHSA1kCLLJCwRCq6mq1bTv0qe05ctZGdC+yQb07uw
HRRhtBVkAYETIIyN6ra9euzvQjH82CCQZZGDq02OjRo92DUQYWEixdutQmTZrk+oUonAeS9O7d23bs2
OHIRt+YUvQ5dOhQW7VqlRNoCEc/nA8iI/AIPmXUv/XWW12bVITKBFw390m/yxfMscsXy11+/yEj7cbxE
106RnogG8gJ44i5BwqGUEfOXLS/mLnOlm47Zjd0qbD/9m/usn49OjtBBZh5CLn2KKRBc3VK5EIotCxaGe

LO+5t77J7OO1z+sk5ft6nTf+HSMdJDhAIQCmIVDKEOnqywH/zyI1u9/aBdLT9h//Yrt9h/fHRysNonVmxI
BDDBSGvlQTs1N3Bt7LF880zTWJepxyJBOXWljaMINX/+fGeqsthwLvaEtB0wYICLMUHRuj/5yU9cu0IFY8
PiRIycMJ6tzssXBQSoa8dgAz6mzEquVQTH1fbq/A22eP1uV86AsOoTR60vCA+rkQ8ESx4eH/ShGPOQfhV
r8GmXK8LXCVF8MnF9nNMH5iR5LBh1EQ/ce++9tnz5cmfKsn9kcVmxYoWtXr3alU+bNs3FhQzGkvlnTpE
RxrcgNBQ3fL6iwg6d+NT+52+X2sIN++3a5Ys2ZnAP+4cffNX6dO/sCIOgoaHYVzE4rDis0qzI7HOOHz/u
yvDesWofOHCgZk/D/gYhxkuHV5C69EE9Avuhffv22d69e+3222937aQV6wvuB49h3759kzkJgokkpJlszE
JWTjldILbsfWJCJnsonC8LFiywGTNmJHNiAC2o0vaMe/EPAyTLWy0QJgSsa2lH69ypg63fddTKLwfCXl7hS

DBhZMJtjIBxTH2Elpg8ORZefvll54ygDOHs37+/rVu3zgkcXjmZipAQBwRlEIiBZ7+CmcbxoEGDnMcvW0J
xjZAUYnONCgITq3Ny/Uy27oXrZtEg7TRVu47WtdcA695nkHXr2cc9DgijT58+zpMZozaYawKLLOPpZCYY

/FavobhFPHMIYnX1Z/azN1bai/M2WFm7SrttSGf740fus6H9e7iVm9WcgYGACBfeOYQQgUSLyZvDg1gEE
4KRr0HluRN7DepzXvIRboSaevSP5iLOFlwfXkCedfkQ0egfsuBQ4bw+NN3kc73/YcqPrehgYkEZ8HC1/dUv
op9D6flYjOvAKmEeWNh4GM54FoxTAqBlEIyzFVX2p8+9b2t2HLbu7arsnlFldsfo3jaof183MAg7ZMKLhqZ
h4CAGQgihIAaDJyJBPkiHeSVNwX6JgW4IQCje3kBDhuFPp6+1wuD6Cf/5wWet3f7Eq0e9vlJuf/rs0zVOC
e6Le0dDLVu2zKZOner6f+CBB+LnVQF4tsgzR2SFsWZxLQinhAAZuPmyjsU2/dE7rVtpBztzqY0t3nHOPjl9

yQ0O+6X169fb9u3b3WoPeIvh448/dhvyTZs2uQeyixcvdg9iWaEY2CVLlti2bducmcfDYOo0FBDqVOtgKh
LVd93kDw3pC0cE2o43NRgTHBVo+xgJpwQyxUJKzGJdUBoKsLpDALTVKwu22d+/tsSqr1Ta05PO2Tcfec



 

22 / 32 

[MS-3DMDTP] — v20140428   
 Data Visualization: 3-D Map Data Tour File Format  
 
 Copyright © 2014 Microsoft Corporation.  
 
 Release: April 30, 2014 

y27z5t5QGR0DyTJ092rxXxsijDhOnGqo6A8bYFJhBvPfDmBIRjgCnTc56HH344edb8ApMODYVpGQbXSY
AMmWio5R+ssyuXEiLQc1CZ3Twx+m3zGJ8HMqC9KoRCrgqOUNwuew200cXKKpv5+su2bfvHdk+/HTbl

7i/Z4Dv/0tau2+g0D287QCgGjTb+UJGWULKXwvyjDoSCtMRRG/x8AEKxVxs4cGDNNaUjkEB96unaY2Q
P5gFSMd/sV5n/giOUwJ6Hwag8u95Orvozu1B+wi5cbmOTn3rHSntNcC+7MkBoHx/phFYC60N5yteQcxx

VPx2YSNzmeAvVr/pS3xA6CjqfCPX8D++3G/udcmXHqu+xJ78fvymRKSASlg6aye2fgjEvWELpts+cOmr
nds20E5v/0c5XXLTi0mHWZthfWGm3QU6VQypMObmaAWm1RzhlSwOZfeQLaDhMSDk21Ib+sLu1t/Ph
9++DfK6JwCT6oEz1SSuQRyCtMu4Ns3Thrx+w+0clHnAvPPqv7f4nfu4eAezcudNpaV7O5cEujgi8ijzwjZE
AhGJxw+PLvLKXKiinhA8JXpviDlbZ8TZr02WclbQvskvn9tq1k3Ns5IihTjuhBXiASmDPgpmFh4vBw6WOJ
5CAcCOgCCqEE+kYdHmBIBZEYhIImImQiTo8ICRPk6SYOpQRSJOvoIfGBIiJ1mX/5gfyKFM510BfXEcqc
M8ICX/a8vrrr9tNN93kjhctWpSsEUNgXplDjWnBaijArSMou3ftsIqji6z4+L8EG/TTVtWmh42f+r+s2+D7A
gG87ATR1yK0Q9ilcThGKzGgmADUJV8koB4ahWOIpyGXlqIvYtr5pprq0ZY0dbQQqAyQJkgz+mU1C0cyF

rg++tu89AXr3D7xKtTVkuE26pavuDTg+mbOnGnf+c53kjkxfGhhk/vcmeDB4Bc0oVjFIUH5uVNWvuc3d
m7n/7OKS9VWNvA+G/uvfmzFHXonayeEMLyyI5QMqohBWg9tpVEgFDECj+ZCuEUc6pBHv8ScwyeNCK
Jp4jhMDpWrrl8OGf026odzcc0xsoesB17xIsYkLliTT0Cw0Qw9evWzYZP+k5V0HW0lbQPNdWiF7d84y65e
qXSCRz0GDdIg/Bwj/ASEU8eYfMQIrvZNBEiLUNOXSEVA69Ev7TmWwAMdE1OuOgJlqq8yYkCaINJo36X
+YuQOFmO9WqY38wuaUAgWwg5BCNXWwfpP+ltr07ajFdtFO398nVVXnqoRQognDYXgikgILeUQSWn1
q2O0FjGrmtpzTN/0A6gvkihQB4TzmTxIShwu8+vL1MRs9a81Ru5gTHmLhPcy9cOqBa+hAIKHsDlitR9s/

Sd838p632zdeo+ytu0Tv6BEOcLJoEEsBFMCCzimHkQSWSgjH0AoVjSOZRqKQIA07WlDmaByQJ8K9KNz
AYgqE1MEgnCkydP5YuQPOKd4vYw5YO4Y44LeQwGEW6s3gorQF7W5alcuHLX2JZ2sQ9mgoFaRE1aEHS
EG1EeoaSP4aYYVzxomHYJMXTaumAbUE0lJU49jaTzaqm/SxATANfjHAvU4j8hEf5CY+vQJyCMA+ifEyB4
QSIsjY4mMFDyhGAzczlrtGRRf2AFDxMARU18ayhdsYsoJSkNOVjCEGiDs9E97yEMd+oFQMifJ1/kpBzoH4
PyUiSThOvRBHfrRdagv1SHNOWJC5QbGmYAloDkpeJNPAslgIHByKgA9uwGUkc+qLzIpH6gfQNoPACLRj
va+ycdkSLDpi2OISBlQe8XU9cmkfIFyyElfBNX1rzOqXYzswLiyGDOfICZUIFi+8KFNEGiIRB4kggCU+YLIA
JKmvoKgtF/mtydNn0yEhF9EQKPJVINUMjWpj4ZTvn/NQNflQ3UFvw5tY+QOzSdzWfAmH7eOucefIzAgC

DOmEoJImS+QEnqIREw9QD0Jp4aSYwgAKdkzKV/tKYe01GGPBWkJ0lqUc8xEQSIC/XA91CGfQD00GnU
ho8il6wnDvz6uhRAje2iBIzCmbm6SZQULBkIvNiLkDAorDYOFwCPgCCICC4mIOaYeA4lAc0ygLwkzZUDC
D+iPfPrUK0qqBziG2BBE/RDTjgABdB0iBIR07trkOaLAtfnn4ThG7kAGJAfMKfMSvykRkAgBBrx9LnMLSIgF
CTqDJ6JJCwnkM8jUI+b5BO3I18DTTn1ABupCJOUBEUp9iUD0oWNAWlNITDnkUnugtOr5/cXIHiy6gHEl
MJ4FTSgIw1NuVhaGAW2DAEuoJbwIKHUBgi8tAiTASgv0w4BDGJ+kiinn3GhH8pgMziHtg5YEOg/1KaMu
ZirmKdfB9RH8aSTt5xOHERMqdzAn/pyDgiYUAi1I6CATwoxpRR4DRh7C6wuqL6TkExhgIEGlf/K0T6KN6q
oMwhFTLmJDLGLti2hHHdVTTBnXJkJTT2na6xqV9vNiQuUO5gH58Me1oAnFSg8YDAkoQEgRagaLfL/Mh4

SUegwukBahDHMQLUUe/dGHCCTi6jy8qUweaQJp6qGJJPicizbSTEBxOuiaVD8mVO7QPAqOWIVKKASMP
RNaAMFCSGPEqA8gFAuiYmTq88tugcDfOxXomhIjR0Ai9t2yPrBkClJDccs8e4JQaCcGI9ZQLQMS1/qYugA

tQhvmOqot/VIHgmCWC9oWAO2FdQ3UJ02eUJCEYh/iDzDA9IvRNKiPCFKXoHlLBdVR38w3j0ggS1Rbyvl
RT/76lj/JYDuAB5bfWhw7dmyNo4pF2N9T0z+kJbh8l1tgYHAgkzblWsWEfScP23+d/Q82a9W8ZE40Vu/d
bH/YutL+/LfPuDZRuFB50dUBi3estoXbV7l0GP84/xUXXw02uS8te8elfby3frHrCywK+kjVj8C5Tpafcem1
+7fYX772M/vNkrdsy+HdVnE50U9zh8jjB8DcKV0XqENdgqyRqHbkQRACpKAev6fBx+74HREee2DB8FN

hpCnXYqz+yXOhED4W4IPBwzOjgRB8tf2rhbPsrx/5E7t54Ej7P/NetBPlpx0pthzZY2+vW2DDeg+0bp262
Pyty23ToV32t49Nt4Nnj9nxoN6ynevs90Hd+VuW29FPT9naA9ussqrSRvYdYvtOHLIF21fbvlOH7UAQBnb
ra6v2brKhvQbY//3wRbt71AR7Z90f7GTFOTt5/oy9vOI9u2XwGPv5/JftyNkT1rushz0XpCFdl5JS1+dvl79
nq/Zttp1H99s7axdaaUmHgHwfufNOGjHeKiovBQT82P582vfc/b4flP3TojesJBAwcOr8OevVpZtLNxVSkU
NzFBVUngqU0S8B7cOiCanYO0eZ99RnoeX3DgGmHiaeyCPNRFrnFRE5ph4oSA3FKoPqZ2AJvrl3PFjVe3d
JfBkQwe1X1tNpotMXyu3mASOsd+fu1r9rb9t9/BMb02eY/fsHHrcf/u4523xwl50JhPPg6WOBkJ61x+/6sv
Xr2tMqLl6wso6dnVZoV9zWvjjmDtcHBJm3eYkjBXhw7GSbt2mpnQ/q9ehUZueC8/3Zl79nf/Pms/bkXdPs

puDcb61dYFPGTLT1n2x3fQGIDZl2nzho06d+y34ZLAaj+gxy52GiIe7wYAEAZ4Pr45oeHvcFO/HpGVu3f5
sN6n79kzhNBWmHcJDwRgXKMwFmHvsiyILQyxvnI7zIQip+2x1AJIhFrD2T2usaRFzyC45Q3Hhd6Btogct
XKm1mYB795qPZdjrQFp07llpRMNA0hRxr920N6vWyUxVnbemONda9Y1lQXmQ7ju23vacPJXsya1+U0A
JVV6/UaIR1B3c4rTZx+LhAO222Ad0SPwLToX2JXQrO+/D4e116b2BCvrH6Axs3cLQt2LrC1gUk6tOle9B

XpX3xhsQ3nCD/xoM7rUfnru76CF07dXWadPHONa7OHcNuDrTVVpu59O2AdIesU/sOAVnPW79uvezQ2e
NW2iH7r4A0NSTIqQLkIGYBZdF0Au+RAHLxrFDPCynjeSAfjMC8o71emKaMNoB8wc9zIcioW8JaEeq6VX
+QMsWslXPtsUlTrbio7gekr66YY09Mvv7zXGDFrg2BNrpgU8d/IZnTuHgtuPbbho610f0SGrIlgvlUSKWx+J

s2zDxIhYYh7ZOLtsw95cQco80ol/Wic0jLybzzoX5iQiWRDaFywbmL55251lRo6vPnA/58SqDDgAR47PDg
sQdC82Du+3tmNBSaSO3VF8E/B1oMokEykdEvBzmZfG+u/tD++9u/sPOXLiRzPo8r167a8t3rnRfrnxe9
mcz9PBZsXeX2LODZeS+5OAzqsHcB87essOOfnnZp4VLV5WAfsix5lLofHzgZNDAXgw08e53KK8EK9Vlt
OzvfaGphbulkyhSQgr8G4K1/Yn2EDi0DKQikIYrkQNouTBY0lv5cB/gERPvxbDNrL9976xfZmH5Dnclz4NQ
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Re2HJbHeCt9b+wfYHG+E1+7bYhCE32gebPgqE06xnaVf7ozsfciQc3LO//dOi123lnk12OLDj39uwKLD1x
9qKvRvthv7Dbe7GJbYh2DOcCvYvpe07ur3GiGCjvWzXumBvccjGDhgZkPMNG9ZroM1c9nZA6Aq7UHk5

2HN86PYIbNppz/7n3jG329Fzp+z5Ba+6/c+sVXNtxe6Nbg/BvqIqsKPvGD42IGOl27uUtGsfLAKBbR2QE4
Kz+WcP1DZCzcdoXpCA+0DYlQ+RpJl8UpAn75/fh19H/aClREi9b4lZyfMrp7lciyywN9jgju6X+DJFVXXC+

4F7dlTfIXb07Em7ZfANrgy37YM3T7YLgYA+/4dXbefxA05ANwcbczxXbMS/N+UxW7h9tXMGAIR3+tSn7
ODpo7Zox8d27NOTLr9dcCPtgrIPNi+1cYNG2TvrFtoPHv5jt7n+eN9m+3f3/ZEdOnPcTgSa62T5WbdHAd
eC6+vYtsQWbltlDFGP0i72wuLZNmPqt2o25WgkHAvgavW1YF9UZB3alTSKtoqRGyT4UVAZjgVpITQQ5B
B5iMnzX3QFqiMyAUgDqdBUkBAy0S+eQMzLrAn1lQlftJ/N+xf77Yr37fVg1R/aM/HxL04+PNAmS3Zd/4If
Ztr5y4EWqbpkndp1sLmbliRLEuQBVwKmty9OeMLOVJQHZFnkNMq+QCPxnEaYdut9tisg5Zh+w93zkzfXf
BiYfmccMd8NNB2kuxYQ4AujbrUuHRKf5Jz98XznOubaigPSEKN50LJHz51MHAftLgTkx2wEwVAGgxjYzVe
rrH3bxHXFaH5g7oAEPhV8R4La+BBRAOWqA1l8+OYhJEWrsSeTe73BnRKfBFqGgOlVF1YGZljPgCBoOAH

t8MsFs2zGQ99K5uQGf3DCt+0PuIBmwhQsLbnuWmZVoh82sakgr1IYPBOpq12M+kFzSJyKULjGBbQKgh
811wDnhD9v0k4+mFvyqUeZPIKYfo1CqFwAoYK1wple+QC3SggPPnnaiILf/e537vM1+/bts1OnTtmjjz7q
PtqM7QwptCrxuRt+KJ48BvPEiRPug88PPfSQmzwGmY9e8/rKnXfeaT/60Y/cJ0RvuOEGGz9+vDuP3ljmO
0z8ECaAdNjknHP69OnuK4oxPg+JLgLtz58Pn1DUZ678nyzwgclHfbSVLyM6D9DH1fy9GO1wSDT770PhI
MgXmYAGxh8gECYYBIAcx44dcwOFYPPRZjxFDB6EYqXjg2TUmzNnjlup+FA15OPDztSBbLt27bI1axIPWc
njKfzKlSvdCkd/tNuzZ4/7UDZlfPSaj2MzaXx3aujQoa5tjOzAXGu+pXHC8y9Q7lsxYTBX4ZdraUNgbl066D

y691aI8GAxAIAhiFrhGECE+5577knm5A4Iw3lvvfXWZM51vPLKK06Doc1ipAfzpjnV/JGneQW+hgIc0wYt
JNFXffLZR7FYRnkDKasx7TzZQeshK+7tiiCjIAjFbdZ1q6lMhhjNF5pTQqaEArz46pt91JdsQAzaoInCey05L
XyTEBKy9+IYq6NgpEgDBjQJSsdoufDJA8LHYfjzTl3V92PMekjCGxY4IdBApCEUxA23AZCPPhuEUFwAF8V
mOxWoEwWp1XwiijT+oMSkatlgDmX6MZd1zSd1/fpRoBwNhWlHX5h/8uqpneTGPyadtcnHt2k/+ugjpyK
PHz9uY8aMsYkTJ9r777/vLoDNOJ4rAm/wLliwwG3CAZt0Hojdf//97o+48Gphf/Kl8RUrVtju3budZ4sb4s1f
+uIceNXmzZtnd999t/OeTZ482fWXDtxi+DY1IEoTYrQsaP40v5pDfy6jTD4WevJx/PhgIceLhzzKfe7LCO3
QUHJAUIbigAPko6Wy1lB4oOiAE/N1cDxUEIk/HyYfgnBCLnzp0qWuzfbt251njDxsWDxoeLy4UD7lj9sYlnN

x7777rrux/v37u5vkLyjJGzlypGsH8XKFBl6DFqNlgnnUHioTyCEBGYDkgBiyoJ107Jt4lGmPRVtklX7IA+Tlx
SmB9kG75AtcGJ/zf+KJJ5I5ibxZs2bZk08+mczJHLrF8K0yUMpLNSEMFvXw/MRoXogSXT+PeUP4JfhyMp
BmywFx5M2jDhqK+fYdFupPpEIO9XAfCwplQB36Il3QXr5UhELb/vrXv3YubAaNgYbc7O94tlQnmvy9v2Di
k5Pf2qG5I5bAM498jV15EABScYyGURucDFhRgt7JQ3tJQwH148cQB0LSHySlDedFTmJCJfN8Qj3zzDPu+
dMjjzziTFoG6vHHH0+WpkFzeJE2+ZJvawcEEPy5BEpDKD+ferTj76PYtgA0DkFvQKSyVgB9seVAi9EPhCJ
wHmfNBBVqS1krhW6TmMDApiJUTkgS6tCmc3ZoQ+JXhxobwd0lU+lx+6NDrX1p9Ltt2YOxTSYbEJpLwF
wKml9iFkPl4QrH4gA41QDl0jLhZ1OC+gPUR0PJ60c+ROLZlns+FWQWHKEEDTqIIhRqnb0T9bSHSjdcQY

8uXvHiXlv4850u3diohlB1X2YNvj/7fivre93EyQuC018Xx2j4ApstwnMa7hMNguaBMMwvWoQ09XGAYdrp
ZWXaqj3lBL8/pZEJyjD3IBamIkSSdsuZULCTi2V/oYtrjtBtEhM0gAw6sU8oXPn83SWOFjyMuOgx+ZiQVM

/PapDUUOtmHbHl/7zfpRsb9SHU0zMnWefe+XW4IHu+MDYU/LkUmEdpGsrwKiPwaCaZc8w52opFEmII
1Afqzz8m7e+dpNkoo1+nnYJ01oTioj788EPbu3evsymHDBni3kHjuRMXK1XbXKDbJCa4m08OFIE3hYWf
/vSn7lHAN77xjRoXf8Z7KCfJnzWhhuKepCfToyE0FOIYDG3GYB4yhV8XGWTutBiSFlRPGoV5ROgRfi2Mm
G0+ocKgf99FThrQD9oNJYIGRJGIrDlpqDfffNN1xjMk/tyBB668ld0cCQW41VS363t8VM+fvMwnPSYUI1U

PjtRjbGvXRcgBeeH5EljsEX4E35lkQR2sKrnHRQSBfiAOZKF/n3BoJPVBOeYepNTLtDkTig7pHMbmzeS7tNf
sWhqzKkuEb1XHxMVdbnZpoMFksJznJrjHzJ9D1ZNQbXgOUg/pywBNvYdCrqOEO9/w55N01DmRUeYOk
mCyMZ/MK2kWfRZSjklDOmLqI9MQhDR9Iw/EjjTBefASSuORp5A1ofCSvPPOO67T/fv31zL5csLOH5id/S
h5kH9wuwQGxb/1ojs+SKYS9zZ37lw3iHoOJZMv3WAFuzIXZ0yott2CRvndwxSaU6IuoKFEDkjEnhhrivNz
jHdOmkiOBfqlPqAe5ciAnBssuDzH4u0d8kUmQk6EwuTT7535Jh8PPzlpNuh99u+s5GLdP4SfC7hdBR/FE6
9/GOB0cG9vv/WWG2StXhCKe0r7YDdJqK1vn7a1Lx516bpQXVQWyH7iaX1egADUY0af+lmpdbmyOXm
UH0CVfBDGR2XfyXatY58aQQcIevg8CD2vq2l++Ytr5lCmG8e8U0o5WxNIBTEo97UQUB/Eymc/hcyj2ZB

7ZAO5IJ90TiYfyLuXrxE0lAbOnwyfUFFDkrmAtCwNNePZSita+VfJozwhOD0/C51PlDw604r635Y8SoB5BJ
qb8LyRjyYhHy2FwPMX1pCBMgKkgmCUR4G26hc5pz9IiymI7MvZIS2YE6Feeukl13lLMvkAqwm3rZUI+C
Zfbqgfoa4UdbOqq/kVvurPMu+vIQiFfAfimjyqjaKiNtaxff0fJEcRqi7RVRkmH4A8EIp8TDvmnjQmIJom/FC
XMsVK0x4CQh7IpLcr0IBC1oSiY94i37lzp+u8pZh8gJVN5oIG1icU1646rETUI84M9SPU5c+62vnLiTZ5gR

OCICQP06FBCEVIwemStkVWWpIdoYoH3F5rEdQcRokw+QBCyTTTnEICtRPJMPnUj9pSFzj5CM4LgXC3y
9tHulevXu5YbXI2+fKORtBQ3LICA+HC7XOTpYn94XPPPedejvUf7DbEHqrSuln5pdo/sJgTnKBkTqin/+6U
dd/6P5JH+UGdhGpXbGUd62/inp/y91bV/abkUQJYGoIIgqCzh9IxCz+ADHj8IA5/YkSZD8mC0gImHQqD

vRakYltDOQFZ4HyQSgvvdbpnCU4Gy2FrS0PUAAr8YSP5vjpH1fPHknWHwS4knms50UofuI58Bddn4t9M
QjdW64j8nAL/5BkIbXis2WYMHjzYxTrmF6s0r8SQjhiTDo8t2smfb78ukBZDptFuLK6QkRdppdlYZCmHuP
RJubRZThrq+eefd6ync38PxapAXjYoPfTXVnz++g/+NxS4bQZBA5lqD6XhUb1gbXJxOmRq8lV+1i2/Jl89
0SBOiTpQ0q7IOneo7dXU2NYF7aH8upob4lR9aKFnrnFIsDUJOyBEIMVoJfrjgTAaDRmHOGgo6nCMxpKm
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g3SUsQhnraF45Wjx4sXugnWB2JItBQyYJiE8GZh2rDqAwfUXBzbb+fyP/wsqJP7JK1KRCWHHFNP+FxLIT
KQM64rFHxkm4MFD+0AONBpkom/kGpkgTRlWizyFMgPVT04aCmZyYjrlhC3Bbe6D1QYwMP4eihcq+eFJ

7s9/sJvZHiqBeu2hLudxD1VPNMQeqi7kcw+l+fOB8GP2CSyIig8fPlxDFEBdZFfkgijMMUBJqJ72UchCFHnV
nuvJiVC8TcCvnvK0uSW5zQV/QnyTjx+fYWAxERhkCMWLsvVBxiZfExOq8U2+7AiVyXOoKEAGApqJ+WQ

fJBc5ZHKLaRDYL+kFaShBIF/0QAY49r29qiNwnLXJx80gbLA2bPKh/lCf2YRrV5tOuIQpU6bYgw8+aE899
ZT7aeX6kqk+yHRP1moQ3C6y4wcJcCYhClF9CdIcmPDsifDKQQpikSlMCuCXiXiQyu/bbwdc/aBC9FU2FR
pRQwF5gfL3HCqBJtNQwWwGIvW5yU6FlqyhEF2C7jVK2FncSbNYM4dop6ix4XUi/094AERCPiASygJNJzK
CKOrk5DZnj8EKwAnlTWlpYNDC4K85f/WrX7mvYxDPnj07WdL8AZkKBRLouogl4YcQ5EMQv1ygnhwWgL
6oB4lYYHWsOlGkJC9rDQXzt2zZ4n7MBPb7e6jm/qZEGAyB75RgD8U9cI8MKKsaZh/3lG+nhHtTojJ/bvPP
qpOC9fn5jkSjOyWyfFMCp8SVHmNrLYBYED64b8p5PqRj5o9FHxlla8I2RSTzgQcQUAd5oB9i2sp5geLgnK
oDRKyaOCjImlD88CQqkHf5/FePckIjm3yAIfAJlQ80lckXnuh0aA1Oibqgh7AQg5dg5bkLg76wsuSwYPzUv

5OP4JhAHfZiEEx5PrI2+XBG4EqeNm2azZgxw7761a/mTqYmQnhQWjKCKU6mCgf+/EnIFRB8iAEJQCr9
QT3f5BOJyONBrkA9aTPKfbhzBg2z0lDgtddec+qTF2RbssnncNucZKI2WNkYqIZySuTb5Gv2Tok8vhyL6E
rwUwE5xNyjHkoA8w2NhdkWbofrPPHKWIIc6h9ScSythNZzXyv0rkXIiVDsn3BMhH9TIic0gcnn4BGKjxOw
KPA2SEt8sMuU1iVkPlr6g93wfUIY7aGA9k/MHfsnNFWqxZF6vhfQpwZ5BPJ4nsVrRvQTPn/e3ObYli3tTYla
8AgFgXitik+CtrgHu8xmZlxyaC17qLBgC5hnPINCPlkcRZioRQe/ACQhhMkkiFD0EyXveSEU35TlA89f+tKX
nKbKCQeeCdi5I3nQiBj9v5OJ/CBTQlVZqV2sysualhUam1DtigOTL/RybCaIIhSmmIgRZX5RhtbB0ydCYdJ

Rl0Uy7O2jHoF6gvoXOGZPhcbjT+fDpMwLoXCf8+3YqVOnOkLxd/vZ7qGaCvzAfBhMgtR6KjMhFTIlVFOjs
QkVhbBQRkGE8okjQmlvI0ikiXmmqDfGqcfeh7mEUJiHfjs0HhrNJ1QY9EnQb6M3CKFaG9hD8dfIDHz9/8
AwgUz3UE2Nxt5DZYtUeyiJrwRbeygdo6EgFERhLvWDLJiB1JX3D9AfZp9c5z44D33qfFGOCVcn+CcmVAi
sXvxEGhrKf7BbH8QaKr+IMvkQXQJEgBw+nHAHBEAzUcac8hVM9sS8IMu8kvYtD/qBaNJQIiUQTXQ+iIq
GxDkBcH5Axs8bnjGcbc1Lsd/+9rftu9/9bsO+HJsUihj1hz9u4TEUGSASZSIOMVoJLQXR/PGnDQHChAF5
0HKQRl/aQDth+kFa2qH9YkKlAQPYkNAkxsgNIobIIUAggvZZpKkT3ncBjllMISGgHiSCMMSQiva8cYEWI2
Yfhemn51oxoerACy+84P7m69VXX03m5BeshJgKmB9hQYiRHiKET44wSaRtGGdpFQhDvu8lFEhTRoBIz

A0kQ6vhJkezqT4ajv5Unz12vIdKAR5Y88V5wCA+9thjeXdKMKFMNBPGytcUaMlOCYmuL8IIue+UwMJgf
HEiMNZoFuoz3tIqHEMMAIEIHDPfzBF7LgBpKEMeSEMyyMk5yaOfmFANhEycEmyAmZC6nt43NFq6U0Ix
Au7viSAEMVoGIkEM8moEPyCS6gB5++iHeYGImHLEEA8iQkz1zT6KY/ph7jg3iE2+JoYmNEb2QKgJkMFP
A7QMgi/nhLQJdSAa5CGmvk80PIB+fUijMoDWgqSUi0wgJlQaMOANJfThyYiRPUSkcFrEQvgx1xQzp9oXA
Y4pkwkHodBKaCnSUeBxStiyiE2+NOALI0zAE0884dQ8D30zwdXKYILSvEXOBGoFZRVsCpR0ClbZ6sSfIz
RnVLcL9j7uW1rXIbJAHokxAj5+/HiXBjwvYnwZZxZHCARRaMu8Ajx40mJ47khLE9UXMaHSYM6cOc6O/v
rXv57MqY2o4dPq6IN64fzmQKiWDBEqDH+cGV9pJkgCwdA6HBPYHxEzP2gijnNBTKhGhE8q0ppoVlVIFa

N+kOiGRdgfY7QOgUURU07HmHtoJghEPWIIlasJHu+hGhH+RAOIxEQ21T6KP09ZtWqV+2HPlogwkYCv
nUhTh8AYYwXobXM5I3i9jDnQvipXxIRqAjDR4dAU4JnamjVrHLFaIkQWoDEMkwJtRJ72UaRZyPDSoZF4F

w9CyfTOFTGhmhhNRSaAcOmrEi0R/oLkE8nfW6GNfE+czGxiCERdjjEB6YN0LogJlScwGUwOcSYhXFcTS5
CdT9qvRzrVOVTml6sv9UPQORRYmYn9vuoKfv/5DH6/6c6he4lajCj387k/AsTSHkkOINJoJ4jFoiJy5oKYU
HmCJoIJTQV/wsITxzGTTmCiielLgu/3W9c5wmXqV+fWOQjsI/jDUP7aGgFNB/oOX3c+keq+lK9r1DWE6
+vYv0btUYkJkApthOucGHJBKOoAxiUXxF6+PIKhJEQJXSpBrKuNoBXZR1Qb8oCfL/JEYcOGDe6vrSdOnG

gjR450eX5d+lGfwO/XP3+6688UOleq/sLnBDomVnlU28ZCrKGaGJkIAEKuVVQhfKw8P590KjIhfLwwipcL
UB+EiavrC1+jjqOEX8IOSOvYTwt+meCf0w8qC0N53GtUeWMiJlQe4U9mWHjCguQjUyEI1+M4HASlo86
ra8Pk4WffcEwAn1SEuq5Z8M8phK9Dx346k76BrhXQVoRXX35oDohNvjxDAsAEKxbqmvTwNITbCqnyBf
WTrg7lxDzchEj+mxrkI7jUYdVPd85c4F+Lj1Tni6rXUNeWDWIN1YDIZaL9tgiRQjpkck7VwRnBH0/ycBdP
mEC5iESI6tO/JoVsQN/htnXdA2V+m7rqNgViQuUZYQHJVNAyESKFVPCFLN15eUvg4MGD7u+F9CfcPnS
eVP2Er4d6aDV5JWWaZQL/etVfOjSH/VIUYkI1ALS6g+Y46QATD1LxK6i85xYFX9BTgXIRyK/LMQ9PMyE
W7ThXeKzUH3FUPzGhCgQSDl/AQPg4n5BQ1gf8Sg9/rpCqne4hFSlUxgIS9jqSByjPhFRR1+CPoV9OOqp

+08Ps/wMvoEIi0PKlZAAAAABJRU5ErkJggg==</Image></Tour></Tours></Visualization> 
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4   Security 

4.1   Security Considerations for Implementers 

None. 

4.2   Index of Security Fields 

None. 
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5   Appendix A: Full XML Schemas 

For ease of implementation, the following sections provide the full XML schemas for this file format. 

Schema name Section 

3-D Data Visualization Tour schema 5.1 

Geo cache schema 5.2 

Region polygon cache schema 5.3 

Tour collection schema 5.4 

5.1   http://microsoft.data.visualization.engine.tours/1.0 Schema 

<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" 

attributeFormDefault="unqualified" elementFormDefault="qualified" 

targetNamespace="http://microsoft.data.visualization.engine.tours/1.0" 

xmlns:tns="http://microsoft.data.visualization.engine.tours/1.0"> 

  <xsd:complexType name="CT_Camera"> 

    <xsd:sequence> 

      <xsd:element name="Latitude" type="xsd:decimal"/> 

      <xsd:element name="Longitude" type="xsd:decimal"/> 

      <xsd:element name="Rotation" type="xsd:decimal"/> 

      <xsd:element name="PivotAngle" type="xsd:decimal"/> 

      <xsd:element name="Distance" type="xsd:decimal"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:complexType name="CT_Frame"> 

    <xsd:sequence> 

      <xsd:element name="Camera" type="tns:CT_Camera"/> 

      <xsd:element name="Image" type="xsd:string"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:complexType name="CT_Scene"> 

    <xsd:sequence> 

      <xsd:element name="Transition" type="xsd:string"/> 

      <xsd:element name="Effect" type="xsd:string"/> 

      <xsd:element name="Theme" type="xsd:string"/> 

      <xsd:element name="ThemeWithLabel" type="xsd:boolean"/> 

      <xsd:element name="FlatModeEnabled" type="xsd:boolean"/> 

      <xsd:element name="Duration" type="xsd:unsignedInt"/> 

      <xsd:element name="TransitionDuration" type="xsd:unsignedInt"/> 

      <xsd:element name="Speed" type="xsd:decimal"/> 

      <xsd:element name="Frame" type="tns:CT_Frame"/> 

      <xsd:element name="LayersContent" type="xsd:string"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:complexType name="CT_Scenes"> 

    <xsd:sequence> 

      <xsd:element maxOccurs="unbounded" name="Scene" type="tns:CT_Scene"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:complexType name="CT_Tour"> 

    <xsd:sequence> 

      <xsd:element name="Scenes" type="tns:CT_Scenes"/> 
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    </xsd:sequence> 

    <xsd:attribute name="Name" type="xsd:string" use="required"/> 

    <xsd:attribute name="Description" type="xsd:string" use="required"/> 

  </xsd:complexType> 

  <xsd:element name="Tour" type="tns:CT_Tour"/> 

</xs:schema> 

5.2   http://microsoft.data.visualization.Client.Excel.LState/1.0 Schema 

<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" 

attributeFormDefault="unqualified" elementFormDefault="qualified" 

targetNamespace="http://microsoft.data.visualization.Client.Excel.LState/1.0" 

xmlns:tns="http://microsoft.data.visualization.Client.Excel.LState/1.0"> 

  <xsd:complexType name="CT_VisualizationLState"> 

    <xsd:sequence> 

      <xsd:element name="cg" type="xsd:string"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:element name="VisualizationLState" type="tns:CT_VisualizationLState"/> 

</xs:schema> 

5.3   http://microsoft.data.visualization.Client.Excel.PState/1.0 Schema 

<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" 

attributeFormDefault="unqualified" elementFormDefault="qualified" 

targetNamespace="http://microsoft.data.visualization.Client.Excel.PState/1.0" 

xmlns:tns="http://microsoft.data.visualization.Client.Excel.PState/1.0"> 

  <xsd:complexType name="CT_VisualizationPState"> 

    <xsd:sequence> 

      <xsd:element name="rp" type="xsd:string"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:element name="VisualizationPState" type="tns:CT_VisualizationPState"/> 

</xs:schema> 

5.4   http://microsoft.data.visualization.Client.Excel/1.0 Schema 

<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" 

attributeFormDefault="unqualified" elementFormDefault="qualified" 

targetNamespace="http://microsoft.data.visualization.Client.Excel/1.0" 

xmlns:tns="http://microsoft.data.visualization.Client.Excel/1.0"> 

  <xsd:complexType name="CT_Tour"> 

    <xsd:sequence> 

      <xsd:element name="Description" type="xsd:string"/> 

      <xsd:element name="Image" type="xsd:string"/> 

    </xsd:sequence> 

    <xsd:attribute name="Name" type="xsd:string" use="required"/> 

    <xsd:attribute name="Id" type="xsd:string" use="required"/> 

    <xsd:attribute name="TourId" type="xsd:string" use="required"/> 

    <xsd:attribute name="XmlVer" type="xsd:unsignedByte" use="required"/> 

    <xsd:attribute name="MinXmlVer" type="xsd:unsignedByte" use="required"/> 

  </xsd:complexType> 

  <xsd:complexType name="CT_Tours"> 
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    <xsd:sequence> 

      <xsd:element maxOccurs="unbounded" name="Tour" type="tns:CT_Tour"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:complexType name="CT_Visualization"> 

    <xsd:sequence> 

      <xsd:element name="Tours" type="tns:CT_Tours"/> 

      <xsd:element name="Colors"/> 

    </xsd:sequence> 

  </xsd:complexType> 

  <xsd:element name="Visualization" type="tns:CT_Visualization"/> 

</xs:schema> 
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6   Appendix B: Product Behavior 

The information in this specification is applicable to the following Microsoft products or supplemental 
software. References to product versions include released service packs: 

Windows 7 operating system 

Windows Server 2008 R2 operating system 

Windows Server 2012 operating system 

Microsoft .NET Framework 4.5 

Windows 8 operating system 

Windows 8.1 

Microsoft Office 365 ProPlus 

Exceptions, if any, are noted below. If a service pack or Quick Fix Engineering (QFE) number 
appears with the product version, behavior changed in that service pack or QFE. The new behavior 
also applies to subsequent service packs of the product unless otherwise specified. If a product 

edition appears with the product version, behavior is different in that product edition. 

Unless otherwise specified, any statement of optional behavior in this specification that is prescribed 
using the terms SHOULD or SHOULD NOT implies product behavior in accordance with the SHOULD 
or SHOULD NOT prescription. Unless otherwise specified, the term MAY implies that the product 
does not follow the prescription. 
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7   Change Tracking 

No table of changes is available. The document is either new or has had no changes since its last 
release. 
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